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1. About Dietplan7 
Dietplan7 is a user-friendly computer program for the nutrition analysis of recipe, 

meals, menus and personal weighed-intake food diaries. It runs on a PC under 32 

and 64 bit versions of Microsoft Windows, from Windows XP to Windows 10. 

Dietplan will also run on any Apple Mac computer under OS X from version 10.6, 

Snow Leopard to 10.11, El Capitan. There are two versions of the software: 

Dietplan7 Professional and Dietplan7 Personal. They are identical in the nutritional 

analysis tasks they can perform, but each is intended for a different type of user. 

Dietplan7 Professional is the version for use in an organisation or department 

where more than one person may be using the software and each user can be 

given specific privileges by an appointed administrator. Depending on the type and 

number of licences purchased, it can be run as a self-contained program on one or 

more desktop or laptop computers, or it can be installed onto a network server 

where the data can be accessed and shared simultaneously by users on different 

workstations.  

The Dietplan7 Personal version is for use by one person. It can be one of two 

models: Installed, where the software is loaded onto one specific computer and 

runs on that machine alone, or Portable where the software is supplied pre-

installed on a flash drive that can be simply plugged into the USB port of any host 

computer, either Windows or Mac, and run without any explicit installation. All work 

is saved on the drive, so you can simply unplug it and carry it with you, then 

continue exactly where you left off when you use it again either on the same, or 

any other computer. 

Dietplan uses a relational database to store both its nutrition data and the details 

of the items that the user inputs for analysis. Nutrition data from multiple sources 

can be stored and all are accessible to any analysis without restriction. Both the 

professional and personal versions of Dietplan are currently supplied with all of the 

data from the UK Nutrient Databank , the most recent components of which are 

McCance & Widdowson's The Composition of Foods, 7th Edition, 2014 and the 

Composition of Foods Integrated Data Set, 2nd revision 2015. The software also 

has the facility for the user to enter the details of as many other additional foods 

and ingredients as required. 

Dietplan7 uses a three-letter data-source code as well as a food-reference code 

to identify each food or ingredient uniquely. Foods from the 7th summary edition 

and the revised Integrated Data Set have the codes MW7 and ID2 respectively. 

The data-source code is also used to identify other sets of food tables that come 

from outside the UK databank, such as USD for the United States Department of 

Agriculture tables and USF or ADF for foods and ingredients and RCP for recipes 

that are added locally. 

Nutrient data is available from a number of other sources. At the current release 

they are contained in two database files, which are available both on the Dietplan7 

installation CD and on line. One file contains product data from UK suppliers, the 

other contains other national food tables. Respectively, these tables and their data-

source codes are:  

UK supplier product tables  

o ABT Abbott Nutrition *  

o BKS Brakes * 
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o DBN Danone Baby Nutrition 

o FRS Fresenius Kabi Ltd * 

o MJN Mead Johnson Nutrition * 

o NCC Nutricia Advanced Medical Nutrition * 

o NES Nestlé Health Science * 

o PSC Pepsico International * 

o SAF South Asian cooked foods 

o TVF Tillery Valley Foods *  

Other national food tables  

o FLV USDA Flavonoid data * 

o IFL USDA Isoflavone data 

o IRL Irish Food Composition Database 

o N10 Australia/New Zealand NUTTAB 2010 

o USD U.S.Dept of Agriculture SR 27 2014 *  

* Updated in Dietplan7   

These food and product tables can be selectively imported into the live database 

from within Dietplan itself, using the Import food tables option from the main 

Admin menu. 

The Dietplan database also includes DRV, Dietary Reference Values (COMA, 1991 

and SACN 2011), RDA, Recommended Daily Allowances (EU Council directive 

2008/100/EC) and the numerically identical NRV, Nutrient Reference Values which 

replace them (EU Regulation 1169/2011), Food Portion Sizes (MAFF 3rd Edition, 

2002) and Nutritional Standards and Requirements for School Food (HMSO, 2007). 

For recipes, Dietplan follows the Food Standards Agency (2013) Guide to creating a 

front of pack (FoP) nutrition label for pre-packed products sold through retail 

outlets. It also produces labelling information calculated from nutritional values 

that comply with EU Regulation 1169/2011 on the provision of food information to 

consumers. The Department of Health / Food Standards Agency Nutrient Profiling 

Model (2004 - 2011) is also supported. Weight loss or gain through cooking as well 

as estimated vitamin losses (McCance & Widdowson, 7th Ed.) can also be entered. 

Nutrient values are calculated as soon as a food or ingredient is added, making it 

easy to observe the effects of adding or subtracting any item. Foods, recipes and 

menus can also be searched, for high or low values of a specified nutrient. 

You can enter and save your own recipes including portion sizes and numbers of 

portions. Once saved, a recipe can be added into any diet assessment or menu 

analysis or into another recipe, either as a food item in its own right, or using the 

individual recipe ingredients. 

The subjects of personal dietary assessments (weighed-intake food diaries) can 

have their details recorded, and an unlimited number of assessments can be saved 

for each individual. These details are used in the computation of the person's DRVs. 

Diaries can be input, and analysed, either as individual days, meals and, if 

required, courses or they can simply be input into a cumulative total that is 

subsequently averaged. If individual meals are input, the time of consumption can 

also be recorded. 

In a similar way, you can design and analyse menus by recording courses and 

meals over any period of days. You can also record a choice of dishes within each 
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course. A nutrition analysis can be performed either for selected choices or for an 

average of all choices in the ratio, if required, of the number of servings of each 

choice dish. 

You can specify and save an unlimited number of food definitions of your own. It is 

also possible to define new constituent nutrients and add values for these to any 

food in the database. 

Individual foods, or lists of foods, can be retrieved from the database either by 

explicit data-source and food reference code, or by specified food group(s) and/or 

diet category code(s). Food names can also be searched to match, or to exclude, 

specified whole or partial words. 

An unlimited number of different portion sizes can be specified for any food either 

by selecting from a range of more than 50 predefined portion types or by defining 

new types. All existing portion sizes can be edited or deleted. 

You can choose which constituent nutrients are to be included in your analyses, 

and the order they are presented. 

Dietplan Professional (only) can be operated in either a completely open manner 

with no restrictions on the user, or an appointed system administrator can set up 

user accounts to control access and specify the rights and privileges of individual, 

registered users. The selections and settings made by a registered user are saved 

between sessions and are unaffected by the selections of other users. 

Results can be presented in the form of reports that can be viewed on screen and 

printed. The component parts of each report are fully user-selectable and can be a 

mixture of tabulated and free-form text and high resolution colour graphics (bar-

graphs, pie charts or histograms). 

Reports are produced as portable document format (PDF) files that can be viewed 

and printed by Dietplan7 using either the built-in PDF viewer or the standard Adobe 

Reader. PDF format is used because of its security; once created, it is safe from 

alteration without using specialised software. It is also a widely accepted form of 

document interchange that is not tied to any proprietary word-processing 

document format.  

It also possible to save reports and graphics in Open/Libre Office (.odt) format. 

Libre Office and Open Office are free software packages that are very similar to 

pre-2007 editions of Microsoft Office. So, if reports are saved in this format, you 

can use Open/Libre Office to load and customise them in the same way as any 

other word-processor document. They can also save documents in Microsoft Office 

(.doc) format and more recent versions of Microsoft Office (2007 SP2 onward) can 

read .odt format documents directly. 

A table of foods and nutrients can be displayed for any analysis in a grid, like a 

spreadsheet. This can also be printed out or exported, either singly or for a 

selection of different analyses, in standard comma separated value (.csv format) 

files to spreadsheet programs such as Excel, Quattro or Supercalc or to statistics 

packages like SPSS or Minitab. 

In addition to being included in reports, high-resolution colour graphics can be 

selected and viewed onscreen. You can choose to view histograms, pie charts or 

bar-graphs for a range of different data, both individual and aggregated. Graphs 

can be printed in monochrome or full colour, depending on your printer. They can 
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also be saved in standard, portable network graphics (PNG) format files that can be 

imported into desktop publishing and other image processing software.  

There are data export and import facilities where selected recipes, menus and 

assessments can be exported and saved to an intermediate database-format file 

and selectively imported by any other Dietplan installation of choice.  

Dietplan also has an optional external data import facility. Catering software 

packages contain information for the bulk preparation of recipes and menus and 

are concerned primarily with stock control, ingredient usage and pricing rather than 

nutritional content. But they do hold the same basic information about the recipes 

and menus that is required by Dietplan for nutritional analysis. To avoid the 

expensive and error-prone re-entry of data, Dietplan has an interface that can 

accept this information electronically from certain catering packages, validate it 

and store it in its own database for subsequent analysis. Catering packages Manna 

(from Oracle Retail) and Menumark (from Datasym Ltd) are currently supported. 

Dietplan is fully documented in this User Guide, which is accessible in PDF format. 

On-line help is also available at any time by selecting Contents & index from the 

main Help menu. The Dietplan software continues to evolve, particularly in 

response to suggestions and requests from users. If you have any specific 

requirements, please let us know. There is a Submit problem or query option, also 

on the main Help menu, that you can fill out on screen and send to us directly as 

an email. 
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2. Installing Dietplan7 
2.1 Hardware requirements 
Any PC running 32 or 64 bit Windows XP or later, or any Apple Mac computer with 

an Intel processor running OS X version 10.6 or later will be more than capable of 

running Dietplan7. 

If Dietplan is installed onto the machine's local hard disk - as opposed to the 

professional version being installed on a network drive or the portable, personal 

version being run from its USB flash drive - about 300 -400 megabytes of local disk 

space will be required, depending on the number of optional, additional food tables 

installed. The database will grow as user-saved work is added, but only by the 

order of a few tens of megabytes. 

A CD reader is not an essential requirement as the purchased software can also be 

downloaded.  

For ease of use, the computer's screen resolution should be set to a minimum of 

1024 x 768.  

2.2 Installing Dietplan 
This applies to Dietplan7 Professional and to Dietplan7 Personal (installed). 

Dietplan7 Personal (portable) does not require installation, it is ready to run - 

simply plug it into a USB port on your computer. It can be either a PC running 

Windows XP or later, or an Apple Mac with OS X 10.6 Snow Leopard or later. To 

start, navigate to the removable drive that appears. With Windows use Windows 

Explorer and double-click the icon dp7-win.exe and with OS X use Finder and 

double-click dp7-osx.sym .  

The Dietplan software is supplied on CD and the installation will begin automatically 

a few moments after the CD is inserted. The software can also be downloaded from 

www.fore-soft.com and installed either as a 30 day trial or, at any time after that, 

as a permanently licenced installation using an activation code that is supplied 

when the software is purchased.  

Windows  

If using the CD, installation should begin automatically. If it does not, double-click 

on dp7install-win.exe. If the software has been downloaded, double-click on the 

downloaded file. When the installation begins, you are given the choice of where 

Dietplan7 is to be installed on your hard disk. The default location is C:\Program 

Files\Forestfield\Dietplan7 . If you wish to install Dietplan on a shared network 

drive, you should specify the destination drive and path at this point. The whole of 

the Dietplan system is installed into the selected destination folder.  

When installing Dietplan onto a shared network drive, it is best done from one of 

the intended client workstations. That way, the desktop shortcut that is used to 

start Dietplan running will be created there. This is the only item needed on each 

individual workstation and it can be copied to as many other workstations as 

required. Dietplan can be made available, via the desktop shortcut, from as many 

locations as you wish but the number of users able to run the software 

simultaneously will be limited by the number of user licences purchased.  

Important Note 

http://www.fore-soft.com/
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When installing under Windows as an Administrator, ensure that the end-users of 

Dietplan have the correct access rights to the Dietplan7 directory/folder and its 

subdirectories. The installer will attempt to set the appropriate rights but cannot 

guarantee to do so under all local circumstances. 

Authorised users (authusers) need the following access rights : 

 

Dietplan7; Permissions: authusers-readexec 

Dietplan7\licence; Permissions: authusers-modify 

Dietplan7\database; Permissions: authusers-modify 

Dietplan7\locks; Permissions: authusers-modify 

Dietplan7\logs; Permissions: authusers-modify 

Dietplan7\imports; Permissions: authusers-modify 

Dietplan7\resource; Permissions: authusers-readexec 

Dietplan7\program; Permissions: authusers-readexec 

Dietplan7\scripts; Permissions: authusers-readexec 

Dietplan7\userguide; Permissions: authusers-readexec  

Mac OS X 

If installing from CD, after insertion, browse to it in a Finder window and double-

click on the file dp6install-osx. This will verify the contents and open a 

dp7install window containing the installer package and a Readme file. Double click 

on Dp7-install.pkg to proceed. If the software has been downloaded, double-click 

on the downloaded file.  

The software is installed using the standard Mac Installer to 

/Users/Shared/Dietplan7. The program itself is 

/Users/Shared/Dietplan7/Program/Dietplan7.app. Use Finder to locate it for 

the first time, then drag it into the Dock for rapid access in future.  

The operation of Dietplan7 is almost identical to the Windows version. There are 

one or two differences, to comply with Apple's Human Interface Guidelines, mainly 

the About Dietplan7 and the Preferences menu items are moved, from the Help and 

Edit menus respectively, into the unique-to-Apple,Dietplan7 item on the main 

menu, at the top of the screen.  

Please note also that throughout this document, mention of the Ctrl key is specific 

to Microsoft Windows; for Mac OS X use the cmd key. 

A preference, which is not available to OS X, is to select Adobe Reader as the 

viewer for PDF reports within Dietplan7 screens. Only Dietplan's internal viewer is 

available for this. However it is also possible to use OS X's own Preview PDF viewer 

to view reports either immediately before printing, or if they are saved to file on 

disk. 

2.3 Activating Dietplan 
Each purchased copy of Dietplan7 is licenced to run the software and to use the UK 

Nutrient Databank and other food tables. Multiple installation and multi-user 

networked versions are similarly licenced for the number of installed copies or the 

number of concurrent network users.  

A freshly installed copy of Dietplan7 Professional or Dietplan7 Personal must be 

activated with a valid licence before it will run. This is done on-line using the 

Activation Code that is supplied at the time of purchase. Dietplan7 Personal 
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(portable) is supplied on a USB flash drive that is already activated with a valid 

licence.  

If you have purchased Dietplan and are installing it for the first time, you can enter 

the 16 character activation code during the dialog that appears the first time you 

run the software. If you have previously chosen to run the installation as a 30 day 

trial, you can enter the activation code by selecting Activate Dietplan licence on the 

Help menu.  

2.4 Running and updating Dietplan 
On Windows, the installation process will create all the necessary program groups, 

icons and, optionally, desktop shortcuts and you can use any method you would 

normally use for starting a Windows program, which will vary depending on the 

version of Windows you are using. The recommended way of running the program 

is to use the desktop shortcut to Dietplan7 that is created by default during the 

installation of the software. 

Under OS X, Dietplan is installed in /Users/Shared/Dietplan7 by default. The 

application to run is ../Program/Dietplan7.app For quick access, drag and drop 

its icon into the desktop dock. 

To run Dietplan7 Portable from the USB flash drive itself, when inserted it will 

appear as an additional, removable drive. To start running, navigate to the top-

level of this drive then, under Windows, double-click dp7-win.exe using Windows 

Explorer or "My Computer", or under OS X, double-click dp7-osx.sym using 

Finder. 

If you run Dietplan7 Portable regularly from one or more computers, it might be 

convenient to copy the appropriate shortcut onto the desktop of each machine.  

Updating Dietplan  

Regular updates to the current release of Dietplan7 are published on the Support 

page of the web site  

http://fore-soft.com and you can check for and download them as they are 

published. They do not usually include new software functionality, which is 

normally introduced only with new releases of the program, but contain fixes to 

discovered and reported problems and are available to everyone. There is also a 

FAQ (Frequently Asked Questions) page where problems and work-arounds are 

reported. 

Users with Dietplan System Administrator rights can also check for updates from 

within Dietplan itself and choose to have them downloaded and installed 

automatically. You can explicitly check for updates at any time by selecting Check 

for updates on the Help menu or you can set up automatic checking, every day, 

week or month using Update checking in Preferences on the Edit menu. If a new 

update is found, you can choose whether or not to download and install it 

automatically. Although network-installed, multi-user installations of Dietplan can 

check for updates in this way, updates themselves cannot be installed 

automatically but must be downloaded from the web and installed at a time when 

no other users are present. 

Updates to new releases of Dietplan are automatically sent to subscribers to the 

annual support and software update service and are available for purchase by non-

subscribers. Updates can be purchased for installations going back as far as the 

http://fore-soft.com/
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original Dietplan6 version 6.10. Please contact Forestfield Software for specific 

prices. 

2.5 Access to Dietplan by multiple users 
The following does not apply to the Personal version of Dietplan as it is licenced to 

a single, named individual.  

The Professional version, even with a single-user licence might be used, at different 

times, by a number of people. Various program settings, such as the nutrients to 

be displayed and the items to be included in a report and any choices made in the 

Preferences option are all saved and are used again until they are changed. This 

means that different users altering settings can easily clash with each other's work.  

A designated administrator can set up individual accounts for each user where their 

settings and preferences are saved independently and files are saved in personal 

folders and sub-folders in their Home directory. The recommended method is to 

link each account to the user's OS (e.g.Windows) login id, so that it is not 

necessary to log in to Dietplan explicitly. 

See Access Management for further details 

2.6 Keeping your data safe 
If your hard disk drive fails or data becomes corrupted, it may be necessary to re-

install Dietplan. However, doing so will not restore any information that you 

yourself have saved or any personal settings you have made.  

To ensure that you do not lose your information, which could be quite substantial, 

you should make a regular back-up copy of the folder ..\Dietplan7 (or the folder 

name you chose when Dietplan was installed) and keep it in a safe place. How 

often you do this is a compromise between how much data you are prepared to 

lose and the inconvenience of making time to do the backup. A daily, weekly or 

monthly backup should be done depending on how frequently information is being 

added to the database. If your organisation has a policy or guidelines on 

performing backups, you should follow these.  

Dietplan also has its own backup and restore options available on the Admin 

menu. The backup function can be used regularly to compress and save the whole 

database onto removable media or a remote network drive of your choice.  

If you have a more comprehensive backup strategy in place for your PC or network 

then, once it includes the Dietplan7 folder in its scope, your data should be 

adequately protected. 

2.7 Removing or transferring Dietplan 
If you have data saved in the Dietplan database on your current machine that you 

want to transfer to a new computer, you must first perform a data backup. This 

can be done conveniently using the built-in Backup and Restore functions of 

Dietplan.  

Once any required backups have been made, you should de-activate the 

installation. This is done on line and releases the licence so it is available for your 

new installation. Run Dietplan for the last time and, with no other activities open in 

the program, select De-activate Dietplan licence on the Admin menu. If you do not 

already have a record of it, take a note of the 16 character activation code that is 

displayed. This will be needed to activate the software at its new location.  
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Using your original CD, install a fresh copy of Dietplan on your new computer and 

enter the 16 character activation code during the dialog that appears the first time 

you run it.  

Restore any data that you backed up from your original computer that you want to 

use. If it was saved using Dietplan Backup, perform a Restore via the Admin 

menu. Dietplan7 on your new computer should now appear exactly as it did on the 

old one.  

When you are happy that this is the case, and if the old computer is to remain in 

service, recover the hard disk space by clicking Start, selecting All Programs, then 

Dietplan7 and Uninstall Dietplan7 to remove the installed software. This will not 

remove any files or data added since the original installation, so also delete the 

folder Dietplan7 (or the folder name you chose when Dietplan was installed). 
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3. Getting Started 
3.1 Main window 
A splash-screen showing Forestfield Software contact information is displayed while 

Dietplan loads and the database is made ready. The main window is displayed in 

the position and at the size it was when last used. Nearly all windows and dialogs 

can be re-sized and moved, and they remember their settings next time they are 

used. There is a reset button in the Preferences dialog to restore them all to their 

original, default values. 

  

If the software has been set up with user accounts that use explicit login id's rather 

than the recommended use of the system's user account names, a login dialog first 

appears for you to enter the login id and password assigned to you by your 

Dietplan system administrator. The password field only echoes asterisks as you 

type. The password is case sensitive, so ensure that Caps Lock on your keyboard is 

off. 

Every time the program starts, a pop-up Tip of the day is shown which contains 

hints about the use of various features of the software. A different tip is shown 

each time that the program starts, but it is possible to step through all of them in 

one session. You can disable the pop-up by removing the tick from the Show tips at 

startup checkbox and enable it by selecting Show tip-of-the-day on the Help 

menu.  

With lower screen resolutions, or if you prefer to work that way, you can maximise 

the main window and the setting will be remembered until you change it.  

Individual recipes, menus and assessments appear inside the main window and you 

can have as many open simultaneously as you wish. Each one appears as a page in 

a tabbed workbook with titles along the top of the window.  

The main window is split into two panes with a vertical sash, which can be dragged 

left and right. The right pane is initially empty but will contain the above analysis 

workbook once work commences. The left pane contains the same items as the 

conventional main menu along the top of the screen, but in the form of an 

expandable tree structure. Items can be selected from either the main menu (or 

the toolbar) or the tree menu with exactly the same effect. The only difference 

between the two menu formats is that as many items as you wish can be expanded 

in the tree and they will remain in that state until changed. It might be easier to 



Dietplan7 User Guide 

 16 

see what items are available and to select them using this format, rather than 

navigate through the conventional menu every time. If you do not wish to use or 

see the tree menu, drag the dividing sash fully to the left, or click the left-most 

icon on the toolbar.  

When there are no analysis workbook items open, the right pane of the main 

window displays a background image. You can select Background image via 

Preferences to select a different image, to specify an image of your own, or to 

choose a plain background colour.  

3.2 Using the toolbar 
The toolbar comprises a set of buttons, along the top of the main window, 

immediately below the menu. They provide shortcut access to frequently used 

items that are also on the menu. If a button is active, i.e. it is not greyed-out, you 

can click it at any time to activate its associated function. The icon on the button is 

a stylised representation of the function. If you pause with the mouse cursor over 

the button, without actually pressing it, a tool-tip appears with a brief description 

of its purpose. The same text also appears in the leftmost pane of the status bar at 

the bottom of the window. The main window toolbar looks like :  

 

and the button functions are, left to right:  

 Show / Hide menu tree  

 Set view-only mode  

 Start a new analysis  

 Open an existing analysis  

 Save current item *  

 Close current item *  

 Print current item *  

 Export to spreadheet  

 Select recipes, menus or diet assessments  

 Composition of foods  

 Select nutrients  

* Current item depends on the context. It is the subject of the active notebook at 

the time the button is pressed.  

3.3 Selecting the type of analysis 
Dietplan can be used for the nutritional analysis of recipes, menus (meal plans) 

and personal diets. Before starting an analysis, you must choose which type you 

are going to use. There are several ways to do this and can choose the method you 

find most convenient.  

From the Tasks menu, choose Select analysis type  

-or-  

Press Ctrl + T  

The following dialog appears :  
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The current selection is highlighted. To change it, click one of the other types, then 

the OK button.  

Alternatively, from the File menu, pause with the mouse cursor over Select 

analysis type until a sub-menu pops up  

   

The current selection is checked. Highlight a new selection and click on it.  

The easiest way of selecting or changing the current analysis type is to select it 

from the drop-down selection list on the main tool-bar.  

   

The currently selected analysis type is displayed in the second status pane at the 

bottom of the main Dietplan window. Your selection remains the same until you 

change it.  

3.4 Setting view-only mode 
Each type of analysis uses a similar notebook style in which the foods, nutrients 

and totals are added, amended and displayed. If you want to ensure that an 

existing analysis is not altered inadvertently while you are just looking at it, you 

can set it into view-only (locked) mode so that no changes are allowed.  

From the File menu, select View only  

-or-  

Press Ctrl + L  
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-or-  

Click the lock button on the toolbar.  

When you set view-only mode, a pop-up dialog asks you to confirm your choice.  

   

When view-only mode is set, all menu items and buttons that could change the 

analysis are disabled and appear 'greyed-out'. 

Selecting view-only for a second time resets it and changes are allowed again.  

   

View-only remains selected just for the current session. Dietplan always starts up 

with database changes permitted.  

3.5 Making multiple selections 
A number of the selection dialogs in Dietplan allow you to make multiple selections 

and you can use the standard method of making multiple selections in Microsoft 

Windows and Mac OS X:  

To select a group of consecutive items, press the left mouse button over the first 

item and, while holding down the button, drag the mouse over the group of items 

to be selected. Release the button when all the required items are highlighted. 

Alternatively, click on the first item, press the Shift key and click on the last item 

in the group. To add other items that are not consecutive, or to remove individual 

items from the selected group, hold down the Ctrl key (the Cmd key on the Mac) 

while clicking each item individually.  

3.6 Entering dates into Dietplan 
Dates can be entered in a variety of formats, and each of the following will be 

examined in turn:  

Day Month Year  

Year Month Day  

Month Day Year  
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The order, in which these formats are examined, depends on the region or locale 

setting of your system, for example, by Windows Control Panel. In the United 

Kingdom the order is as above. 

Days are numeric, in the range 1 to 31. 

Months can be numeric, 1 to 12, short names, Jan to Dec, or full names, January to 

December.  

Years can be two or four digits and two-digit years are converted to four digits 

giving a year up to 99 years earlier than the current date (Dietplan never uses 

future dates).  

A single character should separate the individual fields and may be a space, 

comma, full stop, colon, hyphen or forward slash. The separator can be omitted if 

there is no ambiguity :- 01062003 is acceptable but not 162003 - i.e. use 2 digit 

dd and mm. 

In the UK, dates are displayed and printed by Dietplan in the format DD 

FullMonthName YYYY wherever space permits 

e.g. 21 August 2014 
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4. Foods & Nutrients 
4.1 Composition of foods 
From the Foods menu, select Composition  

-or-  

Click the composition button on the toolbar.  

-or- 

Press Ctrl + M  

 

This opens a multi-tabbed notebook in the main window. The notebook is itself an 

item in the main workbook as can be seen from the tab labelled Food at the top of 

the window. The first page of the food-composition notebook is called Selection, as 

can be seen from the tab labels down the left hand side. Here the task is to identify 

and select the particular food or ingredient whose composition is required. Foods 

and ingredients can be retrieved using any of the food search methods, that is, by 

reference-code, by name word-search or by food group or category code. If more 

than one food matches the search criteria, the results are listed as illustrated 

above. An item can be selected from the list with either the mouse or cursor 

up/down keys. When the required item is displayed in the Selection field at the 

bottom of the window, click the Select button, or press Enter to confirm the 

selection and the next notebook page, Composition, will be displayed.  
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It is also possible to right-click any food on the list to open a pop-up menu. The 

first item is Show composition, which has the same effect as the Select button 

above. The next is Compare foods, which provides a shortcut to the Compare Two 

Foods function and the remaining two options permit any two foods that are listed 

to be selected as the foods to be compared and then to call the food comparison 

function.  

 

Once a food has been selected, you can specify the quantity you want to be 

analysed. This defaults to 100 grams, as in The Composition of Foods but it can be 

altered to any other quantity you wish.  

Many foods have one or more portion sizes defined. To choose one of these, select 

the Portion size field and open the drop-down list of portion types and select the 

one you require. If you wish, you can then select the Number of units field and 
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alter the number of portions from the default of 1. The amount of food for this size 

and number of portions is calculated automatically and displayed in the Quantity 

field.  

You can edit or replace any value in the quantity field. You can specify the quantity 

in grams, ounces (Imperial Measure), millilitres, or any other units added by the 

system administrator by selecting the required units from the drop-down list. The 

default input-units can be changed using the preferences option.  

You can also express the food quantity in terms of the nutrient exchange value by 

clicking on Use nutrient exchanges. Choosing this shows a nutrient field with a 

drop-down list of nutrient names, from which you select one to be calculated. A 

new field called Exchange value also appears in which you enter the quantity of the 

nutrient, in the units shown, that is required from the food. The corresponding 

amount of food is then calculated and displayed in the Quantity field.  

The nutrients and the order they are displayed, depend on the selections made in 

the Select Nutrients option on the Tasks menu. The default selection displays the 

same nutrients and order as published in The Composition of Foods.  

If there is no information in the database about a particular nutrient, the quantity 

is displayed as ---. If there is genuinely none of a particular nutrient present in the 

food, the value is shown as Nil. The value 0+ indicates there are traces of the 

nutrient present, while ++ indicates significant, but unknown amounts. Quantities 

that have been obtained using a derived or a difference method have the suffix d, 

while estimated quantities have the suffix e.  

After viewing the composition of the food you can click Close to exit or Back to 

return to the Selection page to select a different food.  

You can click the Report button or the notebook tab of the same name to format 

the list of nutrient values as a PDF document that can be viewed, printed and/or 

saved.  

You can also click the Graph button or notebook tab to display a graph of the 

food's nutrient content by weight, that is, the relative contribution to the specified 

quantity of the food from protein, carbohydrate, fat, alcohol, water, fibre plus any 

inedible part. Using the Design button on the Graph page, you have the choice of 

showing a bar graph, pie chart or histogram and also how much detail is included. 

You can show just the primary contributions as above, or you can show the 

contributions of starches and sugars to carbohydrate and the proportions of mono- 

poly- and un-saturated fats to the fat total.  

4.2 Select and sort nutrients 
From the Tasks menu, choose Select nutrients to display  

-or-  

Click the select-nutrients button on the toolbar.  

Create or recall a list that specifies the nutrients to be shown in every recipe, 

assessment and menu analysis and the order in which they are displayed. New lists 

are given a name of your choice and you can have as many lists as you wish.  
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The dialog contains two scrolling panes.  

The left, Select nutrients from , pane contains a list of all the available nutrients, 

grouped logically under their sub-headings. The list includes only the nutrients that 

currently have any values in the database. Previously all known nutrients were 

included even if they had no values, for example nutrients only used in the USDA 

table when that table had not been imported. 

The right, Selected nutrients in order, pane contains the list of nutrients currently 

selected, shown in the order in which they will be displayed. 

You can highlight one or more nutrients from the left pane that are not already in 

the selected nutrients listand click Add selection to copy them into the current list 

on the right. Similarly, you can highlight one or more nutrients in the right pane 

and click Remove selection to delete them from the current list. You can start 

with an empty list by using Remove all. To change the order of the selected 

nutrients in the list, highlight one or more nutrients to be moved and click Shift 

selection up or Shift selection down. For each click, the highlighted items will 

move up or down one place relative to the rest of the list.  

You can begin with any previously saved nutrient list by selecting it from the drop-

down choice box. Dietplan has a number of pre-defined lists, including the 

nutrients and nutrient order in the published 5th and 6th editions of The 

Composition of Foods. These are System definitions, as indicated at the foot of 

the dialog, and cannot be altered, although you can make changes and click the 

Save as button to create a new list using a different name.  

Similarly, if individual user accounts have been set up, any lists created by a 

system administrator, using the standard nutrient lists dialog on the Admin menu, 

will appear as Standard definitions which also cannot be changed but, like a 

system definition, can be copied using Save as. A list that you create or copy and 
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save with a name of your own appears as a User definition and it can be altered 

and edited as required.  

All saved system, standard and user lists appear in the drop-down selection list of 

the Name of saved list field.  

To delete a list, select it, use the Remove all button to clear it and then Save the 

empty list.  

The grouping of the nutrients in the Select nutrients from pane is mainly self-

explanatory. The Food labelling group contains nutrient values that are based on 

the data from The Composition of Foods but are computed in a slightly different 

way. These comply with the EU requirements for food labelling: Regulation (EU) 

1169/2011 of the European Parliament . These values are used automatically when 

food label data is requested, but they can also be added individually to your 

nutrient lists in their own right.  

The Properties group contains items that are not strictly nutrients, such as edible 

proportion and specific gravity that come directly from the UK food tables. 

Others, like served edible proportion and specific gravity, conv. are derived 

and are user-modifiable values.  

Served edible proportion (SEP) is the usable proportion of a food in terms of the 

actual nutrient values for that food, rather than the food-preparation wastage 

factor that is sometimes given as the edible proportion (EP). For example, for 

food MW6 748, green beans, raw , the EP is given as 0.83 but the total nutrient 

weight per 100 grams is almost 100 grams, so the SEP is calculated as 1.0. 

However, for UKN 18-211, pork chops with bone , the EP is 0.86 as is the total 

nutrient weight per 100 grams, so the SEP is set the same as the EP. SEP values 

are used during the computation of Nutrient contribution by weight graphs.  

Specific gravity, conv is the value of specific gravity used to convert a quantity 

to grams if it is input as a volumetric unit. Its value can be set by a system 

administrator using the add new nutrients to foods option. If the food is one of the 

few with a specific gravity value in the UK food tables, the specific gravity, conv 

field is initialised with the same value  

There are two nutrient groups containing fatty acids. The first, Fatty acids, 

contains the fatty acids, using the structure-based nomenclature used in the latest 

Fatty acids supplement (1999). The other, Undifferentiated fatty acids, uses 

the non-structure-based nomenclature first introduced with the Fish & fish 

products supplement (1993) and used until the Meat & meat products 

supplement (1997). Use of fatty acids from the former, more recent group is 

recommended. They should not be mixed.  

Finally, the Minerals group has a derived item at the end called Salt equivalent, 

the number of grams of common salt that would be need to supply the quantity of 

sodium present in the analysis.  

4.3 Compare two foods 
From the Foods menu, choose Compare two foods  

Compare the nutrient values of any two foods or ingredients in the database. 

Select two foods and the quantities to be compared (which need not be equal) and 

obtain a list of the two sets of nutrient values together with the differences and 

percentage differences.  
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In Dietplan7, once a recipe has been saved, it can be treated just like any other 

food in the database. It has a data-source code of RCP and a food code identical to 

the recipe code. So you can also use this option to compare any two recipes or, 

indeed a recipe with any other food.  

 

  

The dialog asks for two foods to be selected and for the required comparison 

quantities to be entered. Both foods can be specified either by entering the data 

source and food reference codes directly, or clicking Browse and using dialog with 

any of the Food search methods. Default quantities are 100 grams each but either 

can be changed and the two quantities need not be the same. To view the results, 

click the Compare button or the notebook Result tab.  

The nutrient values of the two foods are displayed together with the differences 

and percentage differences. The display uses the current selection of nutrients . 

Differences are expressed as the amount of the nutrient in the second food relative 

to the amount the first, so selecting the two foods in the opposite order 

will produce different numerical values.  
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You can also click the Report button or the notebook tab of the same name to 

format the results as a PDF document that can be viewed, printed and/or saved.  

4.4 Search foods for nutrient 
From the Foods menu, choose Nutrient search  

Display a list of a selected group of foods showing the values of a chosen nutrient 

per 100 grams, by default, in ascending or descending order.  
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The Nutrient name is chosen from a drop-down list by highlighting the one you 

require. The food tables to be seached (including your own foods and added 

recipes) are selected by ticking the appropriate data sources.  

You can confine your search to a single Food group and/or a single Food category 

by selected from one or both of the drop-down lists. The Food quantity to be 

reported is 100 grams by default but you can alter this as you wish.  

You can also specify a threshold limit for the nutrient quantity, below which foods 

will be excluded from the list. The default threshold value is zero but if you choose 

a very large group or select all foods it may be helpful to set an appropriate 

threshold in order to keep the resulting list to a manageable size.  
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You can alter the order in which the list is displayed by clicking on any of the 

column-header labels. One click will sort the list in ascending order of the selected 

column and a second click will reverse the sorted order.  

You can also highlight any row and display the full nutrient composition of the 

selected food by either double-clicking the row, pressing the keyboard Enter key, 

or clicking on the Show details button.  

Click the Save button to write the list to a text file with a name of your choice and 

save it, or the Print button to output the list to your printer. You can also produce 

a histogram or barchart showing the nutrient content of each food, by clicking 

Graph.  

Click theBack button or the notebook's Selection tab to return and make a 

different selection  

4.5 Nutrient exchange values 
From the Foods menu, choose Nutrient exchange  

Display a sorted list of the nutrient exchange values of a selected group of foods. 

That is, the number of grams of each food needed to provide a specified quantity of 

the chosen nutrient.  

In this option the exchange quantity can be specified for any selected nutrient and 

all the values for a chosen group of foods are calculated and displayed. If you want 

to know the exchange values for single, specified foods use the option The 

composition of foods  
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The Nutrient name is chosen from a drop-down list by highlighting the one you 

require. The food tables to be seached (including your own foods and added 

recipes) are selected by ticking the appropriate data sources.  

You can confine your search to a single Food group and/or a single Food category 

by selected from one or both of the drop-down lists. The Nutrient quantity to 

calculate, that is the exchange value can be entered using the units normally 

associated with that nutrient, so will be shown in grams, milligrams, micrograms, 

kiloCalories or kiloJoules as appropriate.  

You can also specify an upper threshold limit for the computed quantities of foods 

needed to provide the nutrient quantity you have chosen. Quantities above this 

value, representing foods that contain the smallest amounts of the nutrient, will be 

excluded from the list. The default threshold value is 9999 grams but you can 

adjust this as required.  
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You can alter the order in which the list is displayed by clicking on any of the 

column-header labels. One click will sort the list in ascending order of the selected 

column and a second click will reverse the sorted order.  

You can also highlight any row and display the full nutrient composition of the 

selected food by either double-clicking the row, pressing the keyboard Enter key, 

or clicking on the Show details button.  

Click the Save button to write the list to a text file with a name of your choice and 

save it, or the Print button to output the list to your printer. You can also produce 

a histogram or barchart showing the nutrient exchange value of each food, by 

clicking Graph.  

Click theBack button or the notebook's Selection tab to return and make a 

different selection. 
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5. Recipes & Dishes 
5.1 Working with recipes 
Although this section refers explicitly to recipes, these facilities can be used equally 

well for any combination of foods that are often used together. This could be a 

group of ingredients used frequently in other recipes, such as short-crust pastry, or 

a set of foods that are often consumed together, such as toast with butter and 

marmalade and tea with milk and sugar. All recipes can be loaded into other 

recipes or into diet assessments or meals & menus. The recipe can be loaded as a 

single item, under its own name, with the ingredients in the same proportions as 

the original, or the ingredients can be loaded as individual items.  

Check first that the status pane at the bottom of the main window is showing 

Recipes & Dishes. If not, follow the procedure to select the type of analysis  

Start a new recipe:  

From the File menu, select New  

-or-  

From the toolbar, click on the Create new analysis button  

-or- 

Press Ctrl and N  

 

The recipe notebook is opened in the main window, in the Selection page. The 

Recipe code is the key under which the recipe is saved in the database and every 

recipe must have a unique code. It can contain letters, numbers and other 

punctuation characters and be up to 16 characters long. If you are going to save 

many recipes it might be worth devising a simple classification coding system to 

assist retrieval as, when recalling recipes, you can specify and search for all or part 

of the code as well as for words or partial word strings in the recipe name. For 

example, the first two or three characters could be a mnemonic for the type of 

recipe - meat dishes, desserts, cakes etc. The number of codes you use depends 

on how finely you want to divide up your classification. The remaining characters 

could then be digits simply numbering the recipe within the group. Alternatively, 

you could use the whole of the code as an abbreviated recipe name in some way. If 

you are not concerned about the value of the code you can let the software allocate 

one for you: leave the Recipe code field blank, click Accept and the next available 

code in the sequence beginning R00001 will be used.  
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Open an existing recipe:  

From the File menu, select Open  

-or-  

From the toolbar, click on the Open existing analysis button  

-or- 

Press Ctrl and O  

If the recipe is one you have used recently, you can open it from the list of recently 

used items that appears at the foot of the main File menu by clicking on its recipe 

code.  

If you want to look at an existing recipe and be sure that you do not make any 

changes inadvertently, select view-only mode before you open it.  

 

You can search for recipes either by recipe code or by name using the same 

techniques as searching for foods and ingredients . Depending whether you tick 

Using whole words only, matching recipes will be displayed as you enter individual 

letters or whole words. To obtain a complete list of recipes, if not already showing, 

enter a space character into the search field.  

The recipes that match your search criteria will be shown in the scrolling window 

below the search field. Initially in alphabetic, name order you can click any of the 

column headings in the window to sort by that column. A second click on the same 

heading will reverse the sort order for that column.  

You can browse through the recipe list using either a single mouse click or with the 

cursor up/down keys. Details of the currently highlighted recipe appear in the fields 

below the selection list. Make your selection with a double click on the recipe list 

item or press the Enter key.  

Save recipe:  

When you have added all the new recipe ingredients or made amendments to an 

existing recipe, you must save the recipe in the database.  

Click the Save button in the recipe notebook's Composition page  

-or-  

From the File menu, select Save  
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-or-  

From the toolbar, click on the Save analysis button  

-or-  

Press Ctrl and S 

Alternatively, you can choose to have the recipe saved automatically after each 

ingredient is added: Select Edit and Preferences and from the Behaviour 

Preferences tab, select Auto-save analysis after every food entered. This will apply 

to all future analyses until you change it. 

If you have made changes to an existing recipe and you would like to keep the 

original as well as the new version, from the File menu, select Save As and you 

will be prompted for a new recipe code to save the changed recipe. You also have 

the option to amend the recipe name.  

 

By default the same ingredient quantities will be saved in the new recipe (factor = 

1.0) but you can set this to any postive value to adjust all the quantities 

proportionally. For example a factor of 2.0 will double all the quantities and a factor 

of 0.5 will halve them. In the above example, the original recipe was for 4 portions 

and the new version is for 6 (6/4 = 1.5).  

If you have locked the database by using the view-only option, all these ways of 

performing a save will be inactive.  

Delete recipe:  

To delete a recipe, recall it as above andand advance to the Composition page. 

Then from the File menu, select Delete. A warning message will be displayed if the 

recipe is being used in any other analysis in the database. You can still continue 

and delete the recipe but then, when any such analysis is recalled it will warn that 

one of its ingredients is missing.  

Close recipe:  

To close the recipe  

Click the Close button in the recipe notebook's Composition page  

-or-  

From the File menu, select Close, or Close all to close all the open notebooks  
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-or-  

From the toolbar, click on the Close analysis button  

You will be asked to confirm if you try to either close the recipe or exit Dietplan 

without saving any additions or alterations. 

5.2 Entering recipe details 
Once you have entered a new Recipe code for a new recipe, or selected an existing 

recipe, the fields in the Enter/confirm recipe details section of the Selection 

notebook page become active and you can add or edit their contents.  

 

You can enter a descriptive Name. This name appears on all reports and lists and 

alongside the recipe code in the selection window when you are searching for a 

recipe, so helping to identify the recipes found. You can also search for the recipe 

using any word or string of characters occurring in the description. There is no 

restriction on the length of the recipe name.  

You can associate a group code with the recipe if you wish. These are the standard 

1 to 3 character food group codes used to classify all the McCance & Widdowson 

foods in the database. Click the Browse button for a list of available codes and 

their descriptions and select one if required. You can also search for recipes by 

group code, by entering the code into the recipe search field, preceded by an 

equals sign (=), for example =AD  

You can optionally specify recipe portions either as the Number of portions, or the 

Portion size (weight per portion) or both. If you supply at least one of these, 

Dietplan is able to display nutrient information per portion as well as for the whole 

recipe. If no portion information is available, the nutrition per 100 grams is 

reported. However, if you supply both the number of portions and the size, the 

program is able to check that the ingredient quantities entered are consistent with 

these values. When the recipe is saved, if the total ingredient weight is not equal to 

the portion size times the number of portions, a warning is displayed. The program 

offers to adjust the number of portions, the portion size or the individual ingredient 

weights (pro rata) to resolve the inconsistency, and you can choose which item to 

change.  

You can set target Dietary Reference Values for the recipe. This may not always be 

very useful as DRVs refer to the total daily intake of particular population groups, 

but there might be occasions where you want to show the relative contribution of 

the recipe to the DRVs for a typical or targeted group.  
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In a similar way, you can also select and set categories for the recipe. The purpose 

and use of this described in detail in the section on Category coding.  

You can specify changes due to cooking the recipe by clicking the adjacent Set up 

button. You can specify a percentage weight gain or loss, due to the absorption or 

evaporation of water, and you can include estimated vitamin losses based on the 

chosen cooking method. If cooking changes are entered, the button title changes 

to Amend .  

The number of portions, target DRVs and recipe categories can each be given 

predefined values using the Defaults option of the preferences function. The scope 

of a new recipe will show all such default values automatically but they can then be 

edited as required.  

The dates of creation and latest change (if different) are displayed. These fields are 

maintained by the program itself and cannot be altered. If Dietplan user accounts 

have been enabled, the users responsible are also shown. 

When all the details have been entered or amended, click the Continue button or 

the Composition tab of the analysis-notebook to move to the next stage. 

5.3 Cooking changes 
Clicking the Set up button associated with Cooking changes on the recipe Selection 

page brings up the following dialog. The absolute or percentage weight change of 

the raw ingredients during cooking can be entered. If a positive number is entered, 

this is interpreted as a gain due to the absorption of water and if the number is 

negative it is taken as a loss due to the evaporation of water. For gain or loss, the 

nutrient content of the recipe is adjusted proportionately.  
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Guideline values of percentage weight changes during cooking of a wide range of 

foods are included in the 7th edition of McCance & Widdowson's The Composition of 

Foods and these can be viewed by clicking Guide values.  
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It is also possible to choose one of a number of pre-defined cooking methods. If 

chosen, the corresponding percentage vitamin losses, as provided in McCance & 

Widdowson's The Composition of Foods, 7th edition will be applied to each of the 

ingredients. To preview the total values, click Show changes  

 

5.4 Using the recipe composition page 
 

Using the Composition page of the recipe analysis notebook  
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The composition page of the recipe notebook is where all the ingredients are added 

and the current ingredient list and nutrient values are displayed.  

 

The page contains three separate, individually resizable window panes and two 

groups of buttons. The upper-left, scrollable display shows the values of the 

currently selected set of nutrients. Each nutrient shows its total quantity, the 

quantity per portion (if applicable), the dietary reference value (if selected) and the 

quantity per 100 grams. A single-character qualifying indicator is also shown 

alongside each nutrient total, if appropriate. The window has a pale-yellow (by 

default) background to indicate that the contents are read-only.  

The lower-left, scrollable display shows a list of the recipe ingredient source and 

reference codes, weights and names. The Source, RefNo and Weight columns in the 

window have a white background, indicating that the contents can be added or 

edited directly, if required. While not as flexible as adding ingredients using the 

add-foods button, you may find it convenient for adding ingredients whose codes 

are known, or for making adjustments to an ingredient weight. You can also select 

one or more complete rows of ingredients to cut, copy or paste them into any other 

open analysis notebook.  

The upper-right, display shows read-only, summary totals for the recipe on one tab 

and an editable text box in another where free-text recipe comments or 

instructions can be entered. For recipes there are also tabs labelled Allergens, FoP, 

NPM and Label that respectively display allergen information, front-of-pack 

nutrition traffic-light labelling, nutrient profiling model and the recipe food label.  

The Action group of three buttons enables you to add foods and other recipes or 

comments to the recipe or to save the recipe in the database.  
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The Page group of five buttons enables you to switch to any of the other analysis-

notebook pages, namely, Back (Selection), Report, Graph or Grid, or to Close 

the recipe.  

5.5 Recipe allergens 
For recipes, the upper right pane of the Composition page has a tab labelled 

Allergens that contains a summary of the 14* specified allergens in the recipe 

ingredients. For all these allergens, if any of the recipe ingredients positively 

contain that allergen it is reported as Yes, if all the recipe ingredients are each 

declared not to contain the allergen it is reported as No. Otherwise its state is 

reported as unknown (---)    

   

* Food allergen labelling and requirements under the EU Food Information for 

Consumers Regulation No. 1169/2011  

5.6 Front of pack nutrition label 
For recipes, the upper right pane of the Composition page has a tab labelled FoP 

that follows the Food Standards Agency (2013) Guide to creating a front of pack 

(FoP) nutrition label for pre-packed products sold through retail outlets and 

contains front-of-pack nutritional traffic light labelling information for the recipe.  
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Nutrient values per 100g and per portion of the specified nutrients: Fat, Saturated 

fat, Total sugars and Salt are displayed and colour coded green, amber or red when 

the values are low, medium or high according to the guidelines. The percentage 

reference intake for each of the nutrients is also shown  

The recommended levels are different for foods and drinks and the page contains a 

field for this to be specified.  

5.7 Food label 
For recipes, the upper right pane of the Composition page contains a tab entitled 

Food label. This displays information in the format and using the nutrient and 

energy conversion factors specified in the 2011 EU regulations. 
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You can choose to show just the mandatory items or include the optional macro 

nutrients together with a list a list of vitamins and minerals that have values 

greater than 15% of the NRV. You can also show the vitamins and minerals that 

have less than the significant 15% value. 

5.8 Nutrient profiling model (NPM) 
For recipes, the upper right pane of the Composition page contains a tab labelled 

NPM. This displays the results of applying the Nutrient Profiling Model to the recipe 

(Food Standards Agency, 2004 and Department of Health 2011). 
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The model was developed to provide Ofcom, the broadcast regulator, with a tool to 

differentiate foods based on the nutrient content of 100g of the item, in the context 

of television advertising foods to children. 

A simple scoring system awards points for A nutrients (energy, saturated fat, total 

sugar and sodium), and for C nutrients (fruit, vegetables and nut content, fibre and 

protein). The score for C nutrients is then subtracted from the score for A nutrients 

to give the final nutrient profile score. 

Foods scoring 4 or more points, and drinks scoring 1 or more points, are classified 

as less healthy and are subject to Ofcom’s controls on the advertising of foods to 

children on TV. 

The UK foods in the database have been given catagories of FVN or DFVN - 

[Dried] Fruit, Vegetables or Nuts - as appropriate and ingredients with these 

categories are used to compute the percentage FVN content score. They can be 

seen by using the View/Alter button. 
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Temporary changes to the ingredient categories can be made here and will affect 

the current profile score. Permanent changes can be made using the food category 

tools on the Admin menu. 

5.9 Reporting multiple recipes 
From the Views menu, select Recipe summaries.  

With this option you can select a range of recipes from a search-list and either 

produce a detailed report on each one, in the same way that each would be 

reported by the Report page in its own analysis-notebook, or produce a summary 

report in a variety of different formats.  
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You can create a list of recipes from which to make your selections using any of the 

methods you would use to open an existing recipe, or enter an asterisk to display 

all recipes. The candidates are shown in a selection list in the usual way, and here 

you can choose as many recipes as you wish by making multiple selections.  

When all the required recipes have been highlighted, you can select the format of 

the report you want, either a set of detailed reports, or a summary in one of four 

different formats:  

 One recipe summary per table with nutrients listed across the page.  

 One recipe summary per table with nutrients listed down the page.  

 All recipe summaries in one table, nutrients listed across.  
 All recipe summaries in one table, nutrients listed down.  

Each summary report provides information about the nutrient content of each of 

the selected recipes but does not reveal any information about ingredients or 

ingredient quantities. The nutrients reported are those in the currently selected set 

of nutrients, for example:  
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The summary report is written to a PDF file that you can Save or Print in the usual 

way.  
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6. Meals & Menus 
6.1 Working with menus 
Check first that the status pane in the bottom of the main window says Meals & 

Menus. If not, follow the procedure to select the type of analysis  

Start a new menu :  

From the File menu, select New  

-or-  

From the toolbar, click on the Create new analysis button  

-or- 

Press Ctrl and N  

 

The menu notebook is opened in the main window, in the Selection page. The 

Menu code is the key under which the menu is saved in the database 

and every menu must have a unique code. It can contain letters, numbers and 

other punctuation characters and be up to 16 characters long. If you are going to 

save many menus it might be worth devising a simple classification coding system 

to assist retrieval as, when recalling menus, you can specify and search for all or 

part of the code as well as for words or partial word strings in the menu name. If 

you are not concerned about the value of the code you can let the software allocate 

one for you: leave the Menu code field blank, click Accept and the next available 

code in the sequence beginning M00001 will be used.  

Open an existing menu:  

From the File menu, select Open  

-or-  

From the toolbar, click on the Open existing analysis button  

-or-  

Press Ctrl and O 

If the menu is one you have used recently, you can open it from the list of recently 

used items that appears at the foot of the main File menu by clicking on its menu 

code.  
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If you want to look at an existing menu and be sure that you do not make any 

changes inadvertently, select view-only mode before you open it.  

 

  

You can search for menus either by menu code or by name using the same 

techniques as when searching for foods and ingredients . Depending whether you 

tick Using whole words only, matching menus will be displayed as you enter 

individual letters or enter words. To obtain a complete list of menus, if not already 

showing, enter a space character into the search field.  

The menus that match your search criteria will be shown in the scrolling window 

below the search field. Initially in alphabetic, name order you can click any of the 

column headings in the window to sort by that column. A second click on the same 

heading will reverse the sort order for that column.  

You can browse through the menu list using either a single mouse click or with the 

cursor up/down keys. Details of the currently highlighted menu appear in the fields 

in below the selection list. Make your selection with a double click on the list item 

or press the Enter key.  

Save menu :  

Click the Save button in the menu notebook's Composition page  

-or-  

From the File menu, select Save  

-or-  

From the toolbar, click on the Save analysis button  

-or-  

Press Ctrl and S  

Alternatively, you can choose to have the menu saved automatically after each 

item is added: Select Edit andPreferences and from the Behaviour Preferences 

tab, select Auto-save analysis after every food entered. This will apply to all future 

analyses until you change it.  
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If you have made changes to an existing menu and you would like to keep the 

original as well as the new details, from the File menu, select Save As and you will 

be prompted for a valid, unused menu code to save the changed menu details.  

If you have locked the database by using the view-only option, these ways of 

performing a save will all be inactive.  

Delete menu  

To delete a menu, recall it as above and, from the File menu, select Delete  

Close menu:  

To close the menu analysis  

Click the Close button in the menu notebook's Composition page  

-or-  

From the File menu, select Close, or Close all to close all the open notebooks  

-or-  

From the toolbar, click on the Close analysis button  

You will be asked to confirm if you try to close the menu or exit Dietplan before 

saving any additions or alterations.  

6.2 Entering menu details 
Once you have entered a menu code for a new menu, or selected an existing 

menu, the fields in the Enter/confirm menu details section of the Selection 

notebook page become active and you can add or edit their contents.  

 

You can enter a descriptive Name. This name appears on all reports and lists and 

alongside the menu code in the selection window when you are searching for a 

menu, so helping to identify the menus found. You can also search for the menu 

using any word or string of characters occurring in the description. There is no 

restriction on the length of the menu name.  

In the group of fields entitled Scope, specify the range of Days, Meals, Courses 

and, if applicable, Choices of dishes that the menu will cover. You should specify 

the maximum number of days, meals per day, courses per meal and choices per 

course that you expect to encounter. You do not have to use all the groups on 

every occasion and spare groups can be left blank.  
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You do not have to use all the different levels, for example, a school meals menu 

(1 meal a day) could leave the Meals group blank and specify, say, 20 days, 5 

courses and 4 choices. Again a Course is not necessarily an item that is eaten on 

its own, A main dish can be divided into, for example, four 'courses' - a meat 

selection (3 choices, say), a vegetable selection (4 choices), pasta/rice/potatoes 

selection (3 choices), and a salad selection (3 choices). Use the groups in the way 

that best suits your own application. You can name your groups from the defaults, 

for example, Course 1, Course 2, Course 3... etc. to whatever is most appropriate, 

and save the names in each individual menu. See Naming analysis groups.  

Any group level left blank will be omitted from displays and reports.  

At the start of each new menu, you can choose what nutritional standards, if any, 

to associate with the menu. You can choose between the familiar dietary reference 

values and the Nutritional Standards & Requirements for School food 

2007  (NSRS).  

To set the guidelines click the adjacent Set up button and enter or select the 

appropriate details. When guidelines have been set, the button title changes to 

Amend .  

In a similar way, you can also select and set categories for the menu. The purpose 

and use of this described in detail in the section on Category coding.  

The dates of creation and latest change (if different) are displayed. These fields are 

maintained by the program itself and cannot be altered. If Dietplan user accounts 

have been enabled, the users responsible are also shown. 

When all the details have been entered or amended, click the Continue button or 

the Composition tab of the analysis-notebook to move to the next stage.  

6.3 Using the menu composition page 
 The composition page of the menu notebook is where all menu foods and 

ingredients are added and the ingredient list and nutrient values of the current 

menu-group are displayed.  
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The page contains three separate, individually resizable window panes and three 

groups of buttons. At any one time, the contents of the windows refer to the 

current group within the menu, such as Day 2, Course 3, Choice 1 as illustrated. 

The identity of the current group is always displayed in the Status bar at the 

bottom of the main window. It is also shown in the Summary and the Navigate 

tabs in the upper-right window. To review the contents of the entire menu, select 

Review menu contents on the Tasks menu.  

The upper-left, scrollable display shows the values of the currently selected set of 

nutrients of the current group. Each nutrient shows its total quantity, the dietary 

reference value (if selected) and the quantity per 100 grams. A single-character 

qualifying indicator is also shown alongside each nutrient total, if appropriate. The 

window has a pale-yellow (by default) background to indicate that the contents are 

read-only.  

The lower-left, scrollable display shows a list of the menu foods and ingredients in 

the current group. The Source, RefNo and Weight columns of the window have a 

white background, indicating that the contents can be added or edited directly, if 

required. While not as flexible as adding items using the add-items button, you 

may find it convenient for adding ingredients whose codes are known, or for 

making adjustments to an ingredient weight. You can also select one or more 

complete rows of ingredients to cut, copy or paste them into any other open 

analysis notebook.  

The upper-right, tabbed-display has a Summary tab containing read-only, 

summary totals for the current group, a Comment tab with an editable text box 

where free-text menu comments or other notes can be entered, and a Navigate 

tab where the whole menu structure is displayed as an expandable tree. Clicking on 
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an individual leaf node of the tree selects the corresponding menu group in the 

other windows.  

The Action group of three buttons enables you to add foods and recipes and 

comments to the menu and to save the menu in the database.  

The foods in each part of the menu must be added into the correct group, 

corresponding to the day, meal and course and choice. In addition to selecting the 

required section using the tree view as described above, you can also use the Next 

or Previous buttons in the Navigate  group to move forward or go back one group 

at a time. You can also use designated keyboard combinations and items on the 

Tasks menu to move between the groups. See the section titled Navigate between 

analysis groups.  

The Hide empty check box inside the Navigate group can be used to conceal all 

empty menu groups in the menu tree view. Not every meal you enter is likely to 

have the same number of courses and choices, for example, and you can exclude 

the unused groups by clicking this box. It will probably be more useful to do this 

after the whole menu has been entered, but you can check and uncheck the box 

whenever you wish and the tree view will alter to reflect your choice.  

The Page group of six buttons enables you to switch to any of the other analysis-

notebook pages, namely, Back (Selection), Build (Construction), Report, Graph 

or Grid, or to Close the menu.  

6.4 Using the menu construction page 
The construction page of the menu notebook is similar to the small Navigate 

window on the composition page in that it shows a tree-view of the whole menu 

but it occupies the whole notebook page and it contains all the tools needed to 

build and maintain menus.  
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The entire menu is displayed as a tree, with the whole menu at the root and 

branching into days, meals, courses and choices depending on how the menu 

structure has been defined. The food items in the menu are shown as the leaves of 

the tree. Varying amounts of detail can be displayed by clicking the plus (+) and 

minus (-) boxes at the tree nodes or you can click the Expand all or Collapse all 

buttons.  

If a leaf node is selected, i.e. highted by clicking on it, the Show button is active 

and using it displays a dialog containing a grid showing the food items in that part 

of the menu. The grid is the same as the one for the corresponding menu section 

on the composition page. You can also add or edit food items in this grid or use the 

Add item button in the dialog in the same way as on the composition page.  

The construction page also contains buttons that enable you to Copy, Cut, Paste 

or Delete whole sections of the menu, pasting either to a selected part of the same 

menu or to another menu open in a different notebook. The operations can be 

carried out at any level, that is you can copy and paste an entire day to another 

day, a meal to a meal etc. even a whole menu to another menu. Whatever level 

you choose, all the food items contained within that level are copied, cut, pasted or 

deleted. If the receiving level already contains food items you can choose either to 

replace or merge them with the items being added.  

There is also a Paste special button (not shown above) and on the right-click 

menu, that also pastes a previously copied or cut selection with the additional 

option of amending the quantity of each pasted food item in proportion to a 

supplied factor.  
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By default the same food quantities will be pasted (factor = 1.0) but you can set 

this to any positive value to adjust all the quantities proportionally. For example a 

factor of 2.0 will double all the quantities and a factor of 0.5 will halve them. In the 

above example, each of the pasted food quantities are being increased by 10 

percent.  

6.5 Review menu contents 
The list of foods in the Composition page of the menu notebook only shows the 

content of the current group.  

To view of the contents of the whole analysis, from the Tasks menu, select Review 

menu/diary contents.  

 

  

If the menu contains choices and you have selected choices from the menu, click 

the chosen only checkbox to display just the chosen items. 

You can click on any column heading to sort by that column. Click again to reverse 

the sort order.  
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Click Save to bring up a file selection dialog to specify the name of a text file 

where the list, as seen, will be saved. Click Print to send the text of the list to a 

printer. 

6.6 Select choices from menu 
When a menu contains choices of items as the lowest-level grouping, you can 

analyse the choices in a number of ways that can be chosen from the Aggregation 

option in Define report on the View menu or via the Design button on the Report 

page itself . 

One such way is to make explicit choices from the menu and report the chosen 

items. This can be also done conveniently from the Tasks menu by selecting 

Choose items from menu . 

 

The whole menu is displayed as a tree structure and the leaf-nodes of the tree, the 

menu choices, contain selection tick-boxes. Within each set of choices you can tick 

one choice. 

If the tree node you require is in its 'collapsed' state, click the + symbol beside its 

folder icon to expand it. Repeat as necessary at each branch until the leaf nodes 

are showing.  

The choices are saved in the database with the other menu details. They are 

shared, and may be changed by anyone who has access to the menu. 

When choices are made from the menu an additional column is shown in the 

nutrients panel on the Composition page which displays the nutrient totals for all 

the chosen items alongside the nutrient values for the current group of items. 
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The column entitled ChosenTot is updated dynamically so if both the Composition 

page and the Choose items from menu dialog are visible, the nutrient totals can be 

seen to change as items are selected from the menu.  

6.7 Specify number of servings of menu choices 
When a menu contains choices of items as the lowest-level grouping, you can 

analyse the choices in a number of ways that can be chosen from the Aggregation 

option in Define report on the View menu or via the Design button on the 

Report page itself. 

One such way is to specify the number of servings of each choice and produce a 

weighted-average nutrition analysis. This can also be done from the Tasks menu 

by selecting Edit/review menu servings 
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The dialog displays the currently defined set of servings, if any, and allows 

individual servings to be entered or altered. 

New at version 6.60, you can also specify the number of meals provided, in which 

case the numbers of servings entered should reflect the actual number of servings 

of each choice and not just the relative ratio of servings between each choice. If 

this information is entered, the nutritional values of an average meal will be 

reported. 

You can either enter the total number of meals provided for the whole menu cycle, 

in the box at the bottom of the dialog, or you can enter the number of meals 

provided on each day separately. In the latter case, the bottom box is disabled and 

shows the total number of meals calculated from the individual day values. 

If you wish to calculate the number of lunches provided in secondary schools using 

the method currently specified by the Department of Education, namely: 

"The till receipts for a given period for all sales of food to which school lunch 

standards (including nutrient-based standards from 2009) have been applied, 

divided by the monetary value in the dining room of a free school meal, plus the 

number of free school meals actually provided"  
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If you have this information available, click the Meals provided field you wish to 

enter, then the Calculate button and type in the required values in the pop-up 

dialog. Click OK and the calculated value will appear in the field you indicated. 

Servings and meals provided are saved in the database alongside the other menu 

details. They are shared, and may be changed by anyone who has access to the 

menu.  

6.8 Search menu for nutrient 
From the Tasks menu, choose Search menu/diary for nutrients  

Display the values of a chosen nutrient in specified sections of a menu, in 

ascending or descending order.  

 

The Nutrient to find is chosen from a drop-down list by highlighting the one you 

require. You can decide what groups are to be searched, that is, per day, per meal, 

per course or per choice. You can also specify a threshold limit for the nutrient 

content, below which groups will be excluded from the list. If there is a list of items 

chosen from the menu you can tick the box to include only the chosen menu items 

in the search.  

When you click Search a progress bar indicates the progress of the scan through 

the menu.  
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You can alter the order in which the list is displayed by clicking on any of the 

column-header labels. One click will sort the list in ascending order of the selected 

column and a second click will reverse the sorted order.  

You can also highlight any row and display the full nutrient composition of the 

selected food by either double-clicking the row, pressing the keyboard Enter key, 

or clicking on the Show details button.  

You can also click the Save button to put the list into a text file with a name of 

your choice and save it, or the Print button to produce a simple text-only listing on 

your printer.  

Click the Back button to return to the previous dialog and make a different 

selection  
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7. Personal Diet Assessments 
7.1 Working with registrations 
Diet assessments or diaries are entered and stored for named individuals who 

might be clients, patients or customers depending on your circumstances. Before 

the analysis of dietary intake can begin, it is necessary to create or recall a 

registration record for the individual and to enter or confirm their personal details.  

You can enter and save an unlimited number of diet assessments for any 

individual. Each assessment can be either an averaged assessment or a daily 

assessment diary.  

Check first that the status pane in the bottom of the main window says Diet 

assessments. If not, follow the procedure to select the type of analysis  

Create a new registration:  

From the File menu, select New  

-or-  

From the toolbar, click on the Create new analysis button  

-or-  

Press Ctrl and N  

   

The assessment analysis notebook is similar to the ones opened for recipes and for 

menus, except there is an extra tabbed page in front if the Selection tab, entitled 

Registration. It is this page which is opened first.  

For a new registration, enter a unique registration number or code to identify the 

individual being registered. Hospital-based users, for example, will probably use a 

patient's hospital number, but any coding system may be used. It can contain 

letters, numbers and other separating punctuation characters and be up to 16 

characters long.   

If you do not wish to allocate explicit registration numbers you can you can let the 

software allocate one for you: leave the Registration No field blank, click Accept 

and the next available code in the sequence beginning #00001 will be used.  You 

can choose whether or not to include the allocated # (hash) number on reports in 
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the Details tab of the report designer - select Design report on the View menu 

or click the Design button when a report is being viewed.  

Open an existing registration:  

From the File menu, select Open  

-or-  

From the toolbar, click on the Open existing analysis button  

-or-  

Press Ctrl and O  

If the registration is one you have used recently, you can open it from the list of 

recently used items that appears at the foot of the main File menu by clicking on 

its registration code.  

If you want to look at an existing registration and/or assessment and be sure that 

you do not make any changes inadvertently, select view-only mode before you 

open it.  

 

  

You can search for registration records either by number or by surname using the 

same techniques as when searching for foods and ingredients. Depending whether 

you tick Using whole words only, matching records will be displayed as you enter 

individual letters or enter words..  

To obtain a complete list of all registrations, if not already showing, enter a space 

character into the search field or ensure that the Pre-select box is ticked. 

Version 6.70.20 of Dietplan introduced the use of User Groups. During the setting 

up of Dietplan users by an administrator it is possible to designate any user as a 

member of one of the defined user groups (or of None). After that, registration 

records created by a group member will only be visible to members of that group. 

That is, each group will only be able to access its own registrations and 

assessments. Registrations created by a user who is not a member of any group 

will be accessible to everyone, as before. 

The registrations that match your search criteria will be shown in the scrolling list 

below the search fields. Initially in surname order, you can click any of the column 

headings in the list to sort by that column. A second click on the same heading will 

reverse the sort order for that column.  
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You can browse through the registration list using either a single mouse click or 

with the cursor up/down keys. Details of the currently highlighted registration 

appear in the fields in below the selection list. Make your selection with a double 

click on the list item or press the Enter key.  

Save registration:  

There is no explicit action necessary to save the details of a registration. It is done 

automatically as you leave the Registration page of the assessment notebook, 

either by clicking Continue or selecting one of the other notebook page tabs.  

Close registration:  

Having opened or created a registration record, the normal action would be to 

continue and open or create an assessment. However, to close the registration at 

this point:  

From the File menu, select Close, or Close all to close all the open notebooks  

-or-  

From the toolbar, click on the Close analysis button  

7.2 Entering personal details 
Personal registration details are stored in the database. They are stored separately 

from assessments themselves because any person can have an unlimited number 

of assessments and this ensures that the same details are available to each 

assessment and avoids re-entry and duplication of the data. The saved details 

identify the person and provide information to permit the appropriate dietary 

reference values to be calculated. They can also record additional information that 

can be chosen for inclusion in the assessment report.  

The recording of personal data on computer in the United Kingdom is regulated by 

the Data Protection Act. You should ensure that you comply with its requirements 

before entering such information.  

 

  

Surname is the only mandatory item. Sex and Date of Birth are both used in the 

calculation of dietary reference values, so if either are omitted, the selection and 

calculation of DRVs is disabled in all subsequent assessments.  
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Contact details like postal Address, Telephone number and E-mail address are all 

optional.  

Sex can be selected from a drop-down list and Date of Birth can be entered in a 

variety of formats. If you do not know the exact date of birth, enter either the full 

year of birth e.g. 1969 or the current age e.g. 23. The age will be converted to the 

year of birth and redisplayed. Dates in the future are not allowed.  

Height in metres and Weight in kilograms can be included, for reference, on the 

printed report and are used for the computation of the body mass index. The 

weight, if specified, is also used in the calculation of the EAR values for energy.  

The Referred by field can be used to identify of the source of referral of the subject, 

for any other information you wish, or simply left blank.  

You can also include a free-text note of any length which, if present, will be printed 

on the report. This is in addition to the notes and comments that can be included 

with each individual assessment.  

When all the details have been entered or amended correctly, click the Continue 

button or the Selection tab of the analysis-notebook to move to the next stage of 

the analysis, which is to open or create an assessment.  

7.3 Working with assessments 
After confirmation of the registration details, the Selection page of the assessment 

analysis notebook shows a list of all the person's saved assessments.  

 

To create a new assessment, highlight and select the last item in the list, coloured 

blue.  

You can browse through the assessment list using either a single mouse click or 

with the cursor up/down keys. Details of the currently highlighted assessment 

appear in the fields in below the selection list. Make your selection with a double 

click on the list item or press the Enter key. The fields in the Enter/confirm 

assessment details section of the notebook page become active and you can add or 

edit their contents.  

Save assessment:  

When you have made amendments to an existing assessment or added all the 

details of a new one, you must save it in the database:  
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Click the Save button in the assessment notebook's Composition page  

-or-  

From the File menu, select Save  

-or-  

From the toolbar, click on the Save analysis button  

-or-  

Press Ctrl and S  

It is not necessary to supply or to keep track of individual, unique codes for 

assessments. This is handled automatically by Dietplan which links all the 

assessments through the person's unique registration code number. 

Alternatively, you can choose to have the assessment saved automatically after 

each food is added: Select Edit and Preferences and from the Behaviour 

Preferences tab, select Auto-save analysis after every food entered. This will apply 

to all future analyses until you change it.  

If you have made changes to an existing assessment and you would like to keep 

the original as well as the new details, from the File menu, select Save As and you 

will be prompted for a new title to help you to distinguish them.  

If you have locked the database by using the view-only option, all these ways of 

performing a save will be inactive.  

Delete assessment  

To delete an assessment, recall it as above and, from the File menu, select Delete  

Close assessment:  

To close an assessment  

Click the Close button in the assessment notebook's Composition page  

-or-  

From the File menu, select Close, or Close all to close all the open notebooks  

-or-  

From the toolbar, click on the Close analysis button  

You will be asked to confirm if you try to either close the assessment or exit 

Dietplan without saving any additions or alterations.  

7.4 Entering assessment details 
When starting a new assessment you can choose the assessment Type to be either 

an Averaged intake or an Intake diary as in the examples below. 

Once the assessment is created, after clicking Continue, it is not possible to 

change from one type to the other. So at this point a dialog pops up asking you to 

confirm your choice. You can suppress this by de-selecting Confirm assessment 

type when creating new in Edit | Preferences. 
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For an averaged intake assessment you need only specify the number of days over 

which the foods being entered were consumed. No information is recorded about 

when each food was eaten. At the end, an analysis can be produced that reports 

both the total and average daily intake. If your assessments are all usually for the 

same number of days, you can set a default value using the Defaults option in the 

preferences function. Each new assessment will show this value automatically and 

it can be altered if required.  

   

An intake diary assessment records consumption on individual days and also 

(optionally) at individual meals and courses within meals. So it is necessary to 

specify the maximum number of days (and meals and/or courses) that will be 

entered. The foods in each defined sub-group are all entered separately so that 

each can be analysed separately as well as being analysed in specific combinations 

of groups.  

For many assessments, an averaged intake analysis is sufficient and, because there 

is more work involved in entering a full intake diary, it is probably not necessary to 

select this type unless you really need the more detailed breakdown it provides.  

It is not necessary to use all the levels of detail unless you wish to. If you do not 

want meals broken down into individual courses, for example, leave Max courses 

per meal blank and enter all the foods, eaten within each meal, together in the 

same group. Any grouping level left blank will be omitted from displays and 
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reports. You can name your groups from the defaults, for example, Course 1, 

Course 2, Course 3... etc. to whatever is most appropriate, and save the names in 

each individual assessment. 

Two additional, optional items can also be specified in an intake diary: the date of 

each day and the time of each meal. The dates are specified by entering the date, 

or day or the week, of day 1 and subsequent values are are calculated from this, 

assuming the days are contiguous. Either enter the date of day 1 in the appropriate 

box or select the day of the week from its drop-down list. Click Yes or No in the 

Enter meal times radio box if you want to record meal times or not. The times 

themselves are entered in the Add items dialog when foods are added to the diary 

on the Composition page. The time of each meal, as HH:MM, must be entered if 

Yes is selected. If either of these items are recorded, their values appear on the 

Grid page and in csv (spreadsheet) export files. 

The Assessment date is used to calculate the person's age and age-related dietary 

reference values. By default this is the date the assessment is entered into Dietplan 

but it can be amended here.  

You can optionally enter a Title or a brief description of the assessment for 

inclusion in reports and to assist in identifying it during retrieval.  

A snapshot of the persons current Height and Weight is taken from the registration 

record and saved along with the assessment so that future changes in height and 

weight do not alter historical values. These are shown in the dialog and they can be 

altered if you need to change them. You can also enter a Target weight and it will 

be used in the calculation of reference values instead of the actual weight.  

There is an option to choose dietary reference values (DRV) or recommended daily 

allowances (RDA) for the assessment. To set them up, click the adjacent Set up 

button and enter or select the appropriate details. When set, the button title 

changes to Amend .  

In a similar way, you can also select and set categories for the assessment. The 

purpose and use of this described in detail in the section on Category coding.  

The dates of creation and latest change (if different) are displayed. These fields are 

maintained by the program itself and cannot be altered. If Dietplan user accounts 

have been enabled, the users responsible are also shown. 

When all the details have been entered or amended, click the Continue button or 

the Composition tab of the analysis-notebook to move to the next stage. 

7.5 Using the assessment composition page 
The composition page of the assessment notebook is where all assessment foods 

are added and the food list and nutrient values of the assessment are displayed. 

The page varies slightly in appearance depending on whether an averaged intake 

or an intake diary is being entered.  
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A page displaying an averaged intake assessment contains three separate, 

individually resizable window panes and two groups of buttons. The upper-left, 

scrollable display shows the values of the currently selected set of nutrients. Each 

nutrient shows its total quantity, the quantity per day (if applicable), the dietary 

reference value (if selected) and the quantity per 100 grams. A single-character 

qualifying indicator is also shown alongside each nutrient total, if appropriate. The 

window has a pale-yellow (by default) background to indicate that the contents are 

read-only.  

The lower-left, scrollable display shows a list of the food source and reference 

codes, weights and names. The Source, RefNo and Weight columns in the window 

have a white background, indicating that the contents can be added or edited 

directly, if required. While not as flexible as adding items using the add-foods 

button, you may find it convenient for adding foods whose codes are known, or for 

making adjustments to a food weight. You can also select one or more complete 

rows of foods to cut, copy or paste them into any other open analysis notebook.  

The upper-right, display shows read-only, summary totals for the assessment on 

one tab and an editable text box in another where free-text comments or other 

notes can be entered.  

The Action  group of three buttons enables you to add foods and other recipes or 

comments to the assessment or to save it in the database.  

The second, Page group of five buttons enables you to switch to any of the other 

analysis-notebook pages, namely, Back (Selection), Report, Graph or Grid, or to 

Close the assessment.  
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A page displaying an intake diary assessment contains three separate display-

windows and three groups of buttons. At any one time, the contents of the 

windows refer to the current group within the assessment, such as Day 2, Meal 3, 

Course 2 as illustrated. The identity of the current group is always displayed in the 

Status bar at the bottom of the main window. It is also shown in the Summary 

and the Navigate tabs in the upper-right window. To review the contents of the 

entire assessment, select Review diary contents on the Tasks menu.  

The contents of the upper and lower-left, scrollable displays are the same as for 

the average intake assessment described above.  

The upper-right, tabbed-display has a Summary tab containing read-only, 

summary totals for the current group, a Comment tab with an editable text box 

where free-text comments or other notes can be entered, and a Navigate tab 

where the whole assessment structure is displayed as an expandable tree. Clicking 

on an individual leaf node of the tree selects the corresponding assessment group 

in the other windows.  

The Action  group of three buttons enables you to add foods and recipes and 

comments to the assessment and to save it in the database.  

The foods in each part of the assessment must be added into the correct group, 

corresponding to the day, meal and course. In addition to selecting the required 

section using the tree view as described above, you can also use the Next or 

Previous buttons in the Navigate button group to move forward or go back one 

group at a time. You can also use designated keyboard combinations and items on 

the Tasks menu to move between the groups. See the section titled Navigate 

between analysis groups.  
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The Hide empty check box inside the Navigate group can be used to conceal all 

empty assessment groups in the tree view. Not every meal you enter is likely to 

have the same number of courses, for example, and you can exclude the unused 

groups by clicking this box. It will probably be more useful to do this after the 

whole assessment has been entered, but you can check and uncheck the box 

whenever you wish and the tree view will alter to reflect your choice.  

The third, Page  group of six buttons enables you to switch to any of the other 

analysis-notebook pages, namely, Back (Selection), Build (Construction), Report, 

Graph or Grid, or to Close the assessment.  

7.6 Using the assessment construction page 
The construction page of the assessment notebook is active only when assessment 

food diaries, not averaged assessments, are being processed. It is similar to the 

small Navigate window on the composition page in that it shows a tree-view of the 

whole assessment but it occupies the whole notebook page and it contains all the 

tools needed to build and maintain assessment diaries.  

 

  

The entire assessment is displayed as a tree, with the whole assessment at the 

root and branching into days, meals, and courses depending on how the 

assessment structure has been defined. The food items in the assessment are 

shown as the leaves of the tree. Varying amounts of detail can be displayed by 

clicking the plus (+) and minus (-) boxes at the tree nodes or you can click the 

Expand all or Collapse all buttons.  

If a leaf node is selected, i.e. highted by clicking on it, the Show button is active 

and using it displays a dialog containing a grid showing the food items in that part 
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of the assessment. The grid is the same as the one for the corresponding 

assessment section on the composition page. You can also add or edit food items in 

this grid or use the Add item button in the dialog in the same way as on the 

composition page.  

The construction page also contains buttons that enable you to Copy, Cut, Paste 

or Delete whole sections of the assessment, pasting either to a selected part of the 

same assessment or to another assessment open in a different notebook. The 

operations can be carried out at any 'level', that is you can copy and paste an 

entire day to another day, a meal to a meal etc. even a whole assessment to 

another assessment. Whatever level you choose, all the food items contained 

within that level are copied, cut, pasted or deleted. If the receiving level already 

contains food items you can choose either to replace or merge them with the items 

being added.  

7.7 Review  assessment diary contents 
For intake diary assessments, which have their foods and ingredients divided into 

different intake groups, the list of foods in the lower-left window of the 

Composition page of the analysis notebook only shows the content of the current 

group.  

To view of the contents of the whole analysis, from the Tasks menu, select Review 

menu/diary contents.  

 

  

You can click on any column heading to sort by that column. Click again to reverse 

the sort order.  

Click Save to bring up a file selection dialog to specify the name of a text file 

where the list, as seen, will be saved. Click Print to send the text of the list to a 

printer. 
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7.8 Search assessment diary for nutrient 
From the Tasks menu, choose Search menu/diary for nutrients  

Display the values of a chosen nutrient in specified sections of an intake diary 

assessment, in ascending or descending order.  

 

  

The Nutrient to find is chosen from a drop-down list by highlighting the one you 

require. You can decide what groups are to be searched, that is, per day, per meal, 

per course or per choice. You can also specify a threshold limit for the nutrient 

content, below which groups will be excluded from the list.  

When you click Search a progress bar indicates the progress of the scan through 

the diary.  
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You can alter the order in which the list is displayed by clicking on any of the 

column-header labels. One click will sort the list in ascending order of the selected 

column and a second click will reverse the sorted order.  

You can also highlight any row and display the full nutrient composition of the 

selected food by either double-clicking the row, pressing the keyboard Enter key, 

or clicking on the Show details button.  

You can also click the Save button to put the list into a text file with a name of 

your choice and save it, or the Print button to produce a simple text-only listing on 

your printer.  

Click the Back button to return to the previous dialog and make a different 

selection  
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8. Tasks 
8.1 About tasks 
The topics in this section document the items on the Tasks menu and describe the 

things that can be done with an analysis regardless of its type whether it is a 

recipe, a menu or a personal assessment. Not all the tasks are applicable to every 

type of analysis so to find out about the tasks appropriate to a specific analysis 

type, read the section on Recipes & Dishes or Meals & Menus or Personal Diet 

Assessments and follow the links there that point back into this section.  

Two other facilities are also described here under tasks but which are not actually 

on the Tasks menu but on the File menu and the toolbars. These are the Import 

and Export functions.  

8.2 Selecting the type of analysis 
Dietplan can be used for the nutritional analysis of recipes, menus (meal plans) 

and personal diets. Before starting an analysis, you must choose which type you 

are going to use. There are several ways to do this and can choose the method you 

find most convenient.  

From the Tasks menu, choose Select analysis type  

-or-  

Press Ctrl + T  

The following dialog appears :  

   

The current selection is highlighted. To change it, click one of the other types, then 

the OK button.  

Alternatively, from the File menu, pause with the mouse cursor over Select 

analysis type until a sub-menu pops up  

   

The current selection is checked. Highlight a new selection and click on it.  
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The easiest way of selecting or changing the current analysis type is to select it 

from the drop-down selection list on the main tool-bar.  

   

The currently selected analysis type is displayed in the second status pane at the 

bottom of the main Dietplan window. Your selection remains the same until you 

change it.  

8.3 Select and sort nutrients 
From the Tasks menu, choose Select nutrients to display  

-or-  

Click the select-nutrients button on the toolbar.  

Create or recall a list that specifies the nutrients to be shown in every recipe, 

assessment and menu analysis and the order in which they are displayed. New lists 

are given a name of your choice and you can have as many lists as you wish.  

 

The dialog contains two scrolling panes.  

The left, Select nutrients from , pane contains a list of all the available nutrients, 

grouped logically under their sub-headings. The list includes only the nutrients that 
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currently have any values in the database. Previously all known nutrients were 

included even if they had no values, for example nutrients only used in the USDA 

table when that table had not been imported. 

The right, Selected nutrients in order, pane contains the list of nutrients currently 

selected, shown in the order in which they will be displayed. 

You can highlight one or more nutrients from the left pane that are not already in 

the selected nutrients listand click Add selection to copy them into the current list 

on the right. Similarly, you can highlight one or more nutrients in the right pane 

and click Remove selection to delete them from the current list. You can start 

with an empty list by using Remove all. To change the order of the selected 

nutrients in the list, highlight one or more nutrients to be moved and click Shift 

selection up or Shift selection down. For each click, the highlighted items will 

move up or down one place relative to the rest of the list.  

You can begin with any previously saved nutrient list by selecting it from the drop-

down choice box. Dietplan has a number of pre-defined lists, including the 

nutrients and nutrient order in the published 5th and 6th editions of The 

Composition of Foods. These are System definitions, as indicated at the foot of 

the dialog, and cannot be altered, although you can make changes and click the 

Save as button to create a new list using a different name.  

Similarly, if individual user accounts have been set up, any lists created by a 

system administrator, using the standard nutrient lists dialog on the Admin menu, 

will appear as Standard definitions which also cannot be changed but, like a 

system definition, can be copied using Save as. A list that you create or copy and 

save with a name of your own appears as a User definition and it can be altered 

and edited as required.  

All saved system, standard and user lists appear in the drop-down selection list of 

the Name of saved list field.  

To delete a list, select it, use the Remove all button to clear it and then Save the 

empty list.  

The grouping of the nutrients in the Select nutrients from pane is mainly self-

explanatory. The Food labelling group contains nutrient values that are based on 

the data from The Composition of Foods but are computed in a slightly different 

way. These comply with the EU requirements for food labelling: Regulation (EU) 

1169/2011 of the European Parliament . These values are used automatically when 

food label data is requested, but they can also be added individually to your 

nutrient lists in their own right.  

The Properties group contains items that are not strictly nutrients, such as edible 

proportion and specific gravity that come directly from the UK food tables. 

Others, like served edible proportion and specific gravity, conv. are derived 

and are user-modifiable values.  

Served edible proportion (SEP) is the usable proportion of a food in terms of the 

actual nutrient values for that food, rather than the food-preparation wastage 

factor that is sometimes given as the edible proportion (EP). For example, for 

food MW6 748, green beans, raw , the EP is given as 0.83 but the total nutrient 

weight per 100 grams is almost 100 grams, so the SEP is calculated as 1.0. 

However, for UKN 18-211, pork chops with bone , the EP is 0.86 as is the total 
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nutrient weight per 100 grams, so the SEP is set the same as the EP. SEP values 

are used during the computation of Nutrient contribution by weight graphs.  

Specific gravity, conv is the value of specific gravity used to convert a quantity 

to grams if it is input as a volumetric unit. Its value can be set by a system 

administrator using the add new nutrients to foods option. If the food is one of the 

few with a specific gravity value in the UK food tables, the specific gravity, conv 

field is initialised with the same value  

There are two nutrient groups containing fatty acids. The first, Fatty acids, 

contains the fatty acids, using the structure-based nomenclature used in the latest 

Fatty acids supplement (1999). The other, Undifferentiated fatty acids, uses 

the non-structure-based nomenclature first introduced with the Fish & fish 

products supplement (1993) and used until the Meat & meat products 

supplement (1997). Use of fatty acids from the former, more recent group is 

recommended. They should not be mixed.  

Finally, the Minerals group has a derived item at the end called Salt equivalent, 

the number of grams of common salt that would be need to supply the quantity of 

sodium present in the analysis.  

8.4 Food search methods 
Foods and ingredients can be located with food source and reference codes, by 

name or partial name, by food group or by food category. The same methods can 

be used in any dialog or selection panel labelled Food search.  

The recent 7th edition of The Composition of Foods uses sequential food publication 

codes between 1 and 1180, while the Integrated Data Set uses a selection of 

unique databank reference codes from the range 11-001 to 50-1188. So the 7th 

edition foods have both a unique databank reference code and a publication code.  

To handle these different coding systems, and to allow the addition of foods from 

other sources, Dietplan uses two fields to identify each food - a data-source and a 

food-reference code. The data-source is a three-letter code that is unique to each 

code set and we use MW7,  ID2 and UKN to distinguish 7th edition, Integrated 

Data Set, version 2 and full set of UK databank foods respectively. RCP, USF and 

ADF are also used to identify recipes and user-added foods. For each data-source 

any alpha-numeric food-reference codes can be used to identify its foods, provided 

that the codes are unique within that group.  

If you import any of the additional food tables each table you import also has a 

unique data-source code, for example Danone Baby Nutrition (DBN) and Tillery 

Valley Foods (TVF).  

In Dietplan7, everywhere that a food can be specified, there are fields for both the 

data-source and the food-reference code. In cases, where you are searching for 

foods, the data-source is specified as a list of check-boxes via which one or more 

sources can be searched simultaneously. Your current data-source list is always 

remembered and will be used on each occasion until it is changed.  
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After one or more sources have been specified, foods and ingredients can be 

located by food code, by food group or category, or by specifying words or partial 

word strings from the food name. The search is performed based on the 

information that is entered into the Search for field. The field also has a drop-down 

box that holds a list of the last 16 searches performed, any of which can be 

selected and repeated if required. You can alter the number of saved searches 

using the History tab in Edit | Preferences .  

Searches are done automatically as data is entered into the Search for field. The 

search behaviour is modified by the settings of two check boxes in the search 

dialog, both of which are remembered between searches. If Pre-select foods is 

ticked, all foods from your selected data sources are pre-loaded into the list of 

foods when the selection dialog or panel first opens. If you don't want this 

behaviour or it delays the opening of the dialog for too long, uncheck the box. If 

Using whole words only is ticked, searching is only done when complete words are 

entered, otherwise a search is done as each letter is typed. The end of a word is 

detected by the typing of a space or tab - so you need to put a space, tab or press 

Enter after the last word in your search entry.  

The Composition of Food tables are not consistent in their use of singular and plural 

names for food items so whenever a singular name is entered, the search also 

includes the plural version of the name. For example entering potato will find foods 

containing either potato or potatoes.  

To obtain a list of all foods from the selected data sources if they are not pre-

selected, enter a single space character (or an asterisk *, which is retained for 

compatibility with earlier versions).  

You can include as many words or partial word strings as you wish in your search. 

If you want to find foods where a particular word or string is not in the name, 
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prefix the string with a - (minus sign) e.g.-water to exclude all foods with water 

anywhere in the name.  

Every food has an associated food group and often a sub-group, allocated in The 

Composition of Foods. The simplest way to search for foods by group code, or by a 

category code that you yourself have assigned, is to use the group and category 

buttons in the food-search panel to pick the code(s) you want and have them 

loaded automatically into the search string.  

The results of searches are presented in a list, which can be scrolled if there are 

more matches than can be displayed at once. 

 

When  Using whole words only is ticked and the search returns more than one food 

a display window appears after each search operation. This display, dubbed the 

word cloud, contains all the unique words, in alphabetic order, from the foods that 

were found during the search. As you move the mouse over this display, the word 

under the cursor is highlighted with a green background with a red background 

containing a minus (-) sign at the end. A click in the green area will add that word 

into the search critera and repeat the search immediately, while a click in the red 

area repeats the search with that word specifically excluded. This is a way of 

rapidly homing-in on the food you require, especially if your initial search produces 

a long list.  

Previous versions of the program presented the foods in alphabetical order. The 

order is now modified by how soon in each food name the search word(s) appear 

so, for example, if searching for the word cheese , Cheese, Brie appears before 

Cauliflower cheese which appears before Aubergine, stuffed with vegetables, 

cheese topping.  
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To obtain a strict alphabetic listing, click the Name column heading, and again to 

reverse the sort order. Similarly, you can click the other column headings of the list 

to sort in the order of that column.  

To select a food from the list, highlight it using either the mouse or the cursor 

up/down keys, and press Enter, or double-click on the required item.  

Search for Recipes, Menus and Registrations  

All other search dialogs now behave in a very similar way to food searching - 

without the options for specifying data sources, food groups or categories. For each 

search type, the options to Pre-select items and Using whole words only can be 

specified and remembered between searches. The ways of including or excluding 

words and word strings are the same.  

8.5 Add food or ingredient to analysis 
To add a food or ingredient (including a recipe) into any analysis  

Click the Add item button in the composition page of the analysis  

-or-  

Press Ctrl and F  

-or-  

From the Tasks menu, select Add food/ingredient  

This presents a data-entry dialog through which you identify the food or ingredient 

to be added and the quantity required. The ways of specifying or searching for 

foods are described under food search methods.  
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When a food has been selected, its data-source code, food-reference code and 

name will be displayed in the Specify quantity panel. If you want to add the 

contents of a recipe into the analysis, perform a search as above ensuring that 

RCP is one of the data-source items that are ticked.  

Food quantity  

Once a food has been selected, you are asked to specify the quantity you require. 

You can specify the quantity in grams, ounces (Imperial Measure), millilitres, or 

any other units defined by the system manager by selecting the required units 

from the drop-down list. The default units of input can be changed using the 

preferences option.  

Any food quantity that is presented can be accepted or modified as you wish. Use 

the edit keys to alter any value or simply type in the new value over the suggested 

one. Quantities can be entered from 0.1 gram upwards, with an accuracy of 0.1 

gram. Up to 8 significant figures (100 million grams) can be displayed in normal 

decimal notation and larger quantities use scientific (E format) notation, so there is 

no practical limit to the quantities and totals that can be handled.  
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Portion sizes  

Many foods have one or more portion sizes defined. If the Portion size choice field 

is enabled, you can open the drop-down list of portion types and select the one you 

require. If you wish, you can then select the Number of units field and select the 

number of portions you require; the default is 1. The amount of food for this size 

and number of portions is calculated automatically and displayed in the Quantity 

field.  

Nutrient exchange values  

You can also express the food quantity in terms of the nutrient exchange value by 

clicking on Use nutrient exchanges. Choosing this shows a nutrient field with a 

drop-down list of nutrient names, from which you select one to be calculated. A 

new field called Exchange value also appears in which to enter the quantity of the 

nutrient, in the units shown, that is required from the food. The corresponding 

amount of food is then calculated and displayed in the Quantity field.  

Display the composition of food  

If you wish to see the nutrient content of the food before adding it, click the View 

composition button. A pop-up list appears, showing the nutrient content of the 

specified quantity of the food. 

Meal times 

If foods are being added into an intake diary assessment and the recording of meal 

times was specified, a data entry field will appear for this and you will be required 

to enter a time for each individual meal in the diary. Enter the values for the hours 

(HH) and minutes (MM) in 24 hour format or use the spinner buttons to set the 

appropriate values. 

Add the food to the analysis  

Once the food has been identified, enter the required quantity or select one of the 

suggested portion sizes and click Add. The food is added into the analysis and the 

contents of the main analysis window are updated to include the new item.  

Alter a food quantity after entry  

To alter a food quantity after it has been added, select the food again and enter a 

quantity that is the difference between the amount in the analysis and the quantity 

you actually want and click Add or Subtract as appropriate. The quantity in the 

analysis will then be adjusted by this amount. Subtracting more of a food than is 

currently present effectively reduces the quantity to zero and the food itself is 

removed from the analysis.  

You can also adjust the food quantity by entering the new quantity that is required 

and clicking on Replace. The original quantity is overwritten by the new value.  

Add a series of foods to the analysis  

You can choose the action that is taken after a food has been added. If you tick 

Repeat this dialog until cancelled at the bottom of the add-foods dialog, the dialog 

is cleared but remains visible, enabling you to add more foods. This is repeated 

until you click Cancel in the dialog. If the box is not ticked or the tick is removed, 

the dialog closes after the food has been added and it is then necessary to re-open 

the dialog to add another food.  
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8.6 Add or edit food directly in analysis 
The list foods and ingredients that appears in the lower-left window of the 

composition page for every analysis is drawn on a grid whose elements can 

actually be entered or edited in situ. This is an alternative way of adding or 

amending foods and quantities in the analysis instead of using the Add item 

button.  

The range of facilities is more restricted using this method, for example it is not 

possible to search for foods or ingredients. But if you know exactly which food 

codes you want to add, or if you just want to alter an existing quantity, you may 

find this way quicker and more convenient. It is a particularly quick way to remove 

a food from the list entirely, simply select the Weight cell, type 0 (zero), and press 

Tab or click another cell. The whole row containing that food will be removed.  

To alter an existing grid cell, click on it with the mouse. To begin entering a new 

food, click on the first empty cell at the foot of the current list. In each case, the 

cell is an editable field. In the Source column you can enter any valid, three letter 

data-source. Invalid characters are ignored but if you enter any character(s) that 

identify a data-source uniquely, the source code will complete automatically, for 

example you can enter  I for  ID2 or  7 for MW7. In the RefNo column, enter a 

valid food code from the data-source you have chosen. On exit from the cell, the 

food name will appear in the, read-only Food or Ingredient column; otherwise the 

name remains blank. In the Weight column, enter or edit the numeric quantity you 

require. Use the Tab key or the mouse to move between cells. The Enter key 

cannot be used to navigate between cells as it is used as a quick-access key for the 

Add item button.  

When editing a grid row, text is drawn in red during the time that the row contents 

are incomplete or invalid. On successful completion of the additions or changes, the 

colour changes to black.  

If you want to abandon changes before they are complete, you can:  

 Click a cell while holding down Ctrl key to restore the cell to its original 

value  

 Click a row while holding down Shift key to restore whole row to its original 

values  

 Click anywhere while holding down Alt key to restore contents of all red 
cells to their original values  

8.7 Cut and paste foods and ingredients 
The list of foods and ingredients that appears in the lower-left window of the 

composition page for every analysis is drawn on a grid whose elements can be 

highlighted and then copied or cut and pasted into any other food list. 

To avoid activating the grid-cell editing functions when using the Shift and Ctrl 

keys, click on the food name column while making your selections.  

To highlight rows to be copied or moved  

For adjacent rows, either hold down the left mouse button while over the first row 

and drag the mouse down to the last row, then release the button or hold down the 

Shift key and click on the first and the last rows.  

dietplanAdd_a_recipe.htm
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For non-adjacent rows, or to add individual rows to or remove them from an 

existing selection, hold down the Ctrl key and click on the required row, repeating 

as necessary.  

To highlight all the rows  

From the Edit menu choose Select all or press Ctrl and A together  

To copy your selection  

From the Edit menu, select Copy or press Ctrl and C together.  

To move (cut) your selection  

From the Edit menu, select Cut or press Ctrl and X together.  

To delete your selection  

From the Edit menu, select Delete or press Ctrl and Delete together.  

To paste your selection  

You can copy or move your selection to any other open analysis or into any other 

menu group or assessment diary page in the same analysis. Select the receiving 

analysis using the tabs along the bottom of the main workbook. If this analysis has 

more than one section, i.e. there is a Navigate tab in the top-right window, select 

the required (Day, Meal, Course) group so it is displayed. Then, from the Edit 

menu select Paste or press Ctrl and V together.  

8.8 Add notes and comments 
lick the Comment button in the analysis Composition page  

-or-  

Click the Comment tab in the analysis Composition page  

-or-  

Press Ctrl and R  

-or-  

From the Tasks menu, select Add remark/comment  

Select this option if you want to add free text to your analysis.  
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Type your text directly into the comment-tabbed window. It will automatically word 

wrap at the end of each line, but you can press Enter at any time to start a new 

line.  

Use the mouse or cursor keys to position the cursor over any existing text and 

insert more text or use the delete or backspace keys to correct errors. You can use 

the Copy (Ctrl+C), Cut (Ctrl+X) and Paste (Ctrl+V) keys to insert, delete or move 

blocks of highlighted text.  

If the entry window becomes full it will scroll down automatically to allow more text 

to be entered without limit.  

You can choose to include this text with your analysis when you create a report.  

8.9 Navigating analysis groups 
Some types of analysis, that is, menus and intake diary assessments, require you 

to divide the analysis into a specified number of days, meals, courses and choices 

of dishes. These are referred to as analysis groups and the foods intended for, or 

consumed in each individual group are entered and stored separately within each 

group.  

In the main analysis window, the current group is always shown, at the top of the 

window shown on the Summary tab as the Day, Meal, Course and, where 

applicable, Choice number. Only those items appropriate to the current analysis 

are shown. So, for example, if you have not chosen to divide your analysis into 

individual courses, the Course field will not be shown. The current group is also 

shown highlighted in the window on the Navigate tab.  

When entering or reviewing the contents of an analysis in the main window, you 

need to be able to navigate, or move, between analysis groups. In addition to the 

individual methods detailed below, you can always use the tree in the Navigate 

window to click on the group node you require, which selects it immediately. If the 
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destination group is not showing, it may be necessary to expand the view by 

clicking on + where the branch is collapsed.  

To move or return to the first analysis group in the sequence :  

Press Ctrl and Cursor-Up  

-or-  

In the Tasks menu, select First group  

To move to the next group in sequence :  

Click the Next> button on the composition page of the analysis  

-or-  

Press Ctrl and Cursor-right  

-or-  

In the Tasks menu, select Next group  

To move to the previous group in sequence :  

Click the Prev button in the main analysis window  

-or-  

Press Ctrl and Cursor-left  

-or-  

In the Tasks menu, select Previous group  

To move to a specific group  

Press Ctrl and G  

-or-  

In the Tasks menu, select Go to group  

Then select the group you require by entering the appropriate numbers or clicking 

the up or down arrows on the spinner  

 

Click OK to go to the selected group. Both the main analysis window and the 

navigation tree view will be updated with this group.  
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8.10 Naming analysis groups 
When first created, analysis groups have the default names Day 1, Day 2, ... and 

Meal 1, Meal 2... etc. but you can change these names for each individual analysis. 

You can use any set of names that best suits, for example, a school meals menu 

could be given day groupings of Week 1 Monday, Week 1 Tuesday etc. Each 

day, meal, course and choice group can be named as you wish.  

To change any name, from the Tasks menu, select Edit group names  

 

In the Select type radio box, select which group name you wish to alter - Day 

names, Meal names etc. Only the groups that have been set up can be named.  

Then, in the grid, enter or amend each of the names in that group and repeat for 

each type of group as required.  

All the names you define will be saved along with the analysis and will remain 

associated with that individual analysis until you change them. The navigation tree 

view in the main analysis window will be updated to use the names you have 

entered.  

To review the complete set of names, from the Tasks menu, select Review group 

names.  
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8.11 Using dietary reference values 
Dietary reference values are set up in the Selection page of each analysis 

notebook.  

Click the button labelled Add or Amend in the panel labelled Target DRV (recipes), 

Nutritional guidelines (menus), or Dietary reference values (assessments).  

-or-  

From the Tasks menu, select Dietary reference values  
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This dialog allows you to select one of the sets of Dietary reference values 

recommended by COMA (1991) and SACN (2011), namely,   Reference Nutrient 

Intake, Estimated Average Requirement or Lower Reference Nutrient Intake. Your 

can also give values to the various parameters that affect the DRVs.  

If you are specifying DRVs for a particular individual, their age and sex from the 

personal details entered earlier are displayed but cannot be altered here. Age is 

computed from the date of birth to the date of the current assessment.  

If you are doing a recipe or menu analysis, that is not associated with any 

particular individual, you can, if you wish, provide a set of "target" DRVs by 

specifying an appropriate age and sex.  

There are fields in the dialog where you can specify the person's activity level and 

state of pregnancy or lactation. These are disabled where the person's age or sex is 

not appropriate. They are multiple-choice fields, click the drop-down box to select 

the one you require. It is not essential to choose activity levels, but doing so will 

produce a closer estimate of energy requirements.  

You can choose whether the target energy requirements should be met from food 

alone or from food plus alcohol. You can also decide whether to take the target 

protein intake as the DRV, which is a fixed quantity, or to use 15% of the energy 

DRV that protein provides to the population as a whole.  

The value for carbohydrate can be chosen either as the one that provides the 

recommended percentage contribution to energy, or as the one that will provide 

the balance of the energy requirement that is not supplied from other sources.  
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When you click OK, the specified set of DRVs are calculated and these will appear 

alongside each constituent nutrient in displays and in reports. The current settings 

are stored when the analysis is saved.  

The only type of DRV defined by COMA for carbohydrate, fats and energy are 

Estimated Average Requirements (EAR) so these are always used irrespective of 

your choice of DRV type for the other nutrients. If RNI or LRNI values have been 

selected, an asterisk indicates any values that are EAR.  

8.12 Guidelines for school meals 
For menus only, instead of setting dietary reference values, you can also select 

the Nutritional Standards & Requirements for School food 2007 (NSRS).  

Select NSRS in the Nutrition standard selection box on the Selection page of a 

menu and click the button labelled Add or Amend  

 

The type of school can be specified in terms of pupil gender and age range. Select 

the appropriate settings from the drop-down list in each case.  

Unlike dietary reference values, the school meal guidelines often recommend 

minimum or, in some cases, maximum nutrient levels. These are shown on screen 

and in reports using the > (greater than) and < (less than) symbols, for example 

> 65.2 g CHO or < 6.0 g saturated fats.  

8.13 Data export 
The contents of any analysis can be written to an export file in a standard, comma-

separated variable (csv) format that can be imported into other spreadsheet and 

statistical analysis software.  

To initiate the export of data from an open analysis, click the Export button on the 

Grid page of the analysis notebook.  
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To select one or more sets of data to be exported:  

From the File menu, select Export to spreadsheet  

-or-  

From the toolbar, click on the Export button  

-or-  

Press Ctrl and E 

 

You can search for and select analyses of the currently selected type, that is, 

recipes, menus or assessments.  

Enter your search criteria into the Search for field in exactly the same way as when 

you locate an analysis to open it.  

The matching items are listed and you can select one or more to be exported.  

To select a block of adjacent items, hold down the Shift key and click on the first 

and last items in the group. The whole block will be highlighted. To add non-

adjacent items, or to remove an item from the selection, hold down the Ctrl key 

and click on the required item.  

Use the Choose export method radio-box to export summaries of your selected 

items into a single file or to export details of each selected item into a single file or 

to separate files.  

When you click the Export button, you can choose or confirm the output file name 

if there is a single file, or select/confirm the destination directory for multi-file 

creation. By default, each file name will be the corresponding recipe, menu or 
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registration code and have the extension .csv. Spreadsheet programs like Open 

Office Calc, Microsoft Excel and Corel Quattro-Pro can recognise and import .csv 

files automatically so the file extension should not be changed. By default the files 

are saved in the csvexports folder of your Dietplan7 work area, but you can 

change the folder using the Preferences option. 

By default, fields containing nutrient values are formatted as when they appear on 

the corresponding Composition page of each analysis. That is, zero values show 

as Nil, missing values as --- and other values may be non-numeric or have a non-

numeric suffix. If you require that only numeric nutrient values are exported, select 

Exported nutrients to contain only numeric values in the Spreadsheet export tab of 

Edit | Preferences. 

8.14 Data import 
Dietplan has a data import module that can be used to import recipes and menus 

from other software such as catering packages. Although it is completely general 

purpose in design, the module needs to be tailored to the specific formats of the 

data being exported by the catering software provider.  

This has been done for providers of software, such as Manna (Oracle UK) and 

Menumark (Datasym) and the import module is enabled in the Dietplan software 

licences of their customers. The import module is disabled by default, but if you 

have a requirement for importing recipes or menus from any source, please discuss 

this with Forestfield Software.  

Once enabled, importing data is completely automatic. Data files are placed into a 

pre-agreed directory and Dietplan looks there for any waiting files whenever it is 

run by a user with appropriate privileges. The file contents are validated before any 

action is taken and are only processed if they are error free. An acknowledgment 

file is created for each data import file that contains details of all actions, errors 

and queries.  

When the data import module is active, you can select View imported files from the 

File menu to view or edit the most recent data and acknowledgment files or to 

select and view any other file in the import folder.  

8.15 Category coding 

8.15.1 Category coding 
This is an optional but a powerful feature of Dietplan for declaring and defining 

dietary categories and then assigning them to individual analyses and/or to foods 

and ingredients.  

For example, you could define a category of Vegetarian and start a new analysis, 

say a recipe, and declare it to be vegetarian. Then as foods and ingredients or 

other recipes are added, any items that were not themselves vegetarian would 

raise a warning. The whole purpose of category coding is to help to ensure that the 

recipes, menus or assessments you are working on comply with any criteria you 

have set for them.  

While some categories can be defined and computed from the nutrient values held 

in the database, such as Low fat or High energy, using arbitrary threshold values, 

many if not most categories can only be declared, as they depend on food 

characteristics about which no quantitative information is available. Examples of 

such declarations are vegan, halal, nut-free, no added colouring etc. Ideally, every 
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food in the database needs to be flagged whether or not it complies with each of 

the declarations. It soon becomes apparent that, not only does there need to be 

common agreement on the exact interpretation of a declaration, but also much 

work is necessary to achieve the tagging of each food. The implementation of 

category definitions in Dietplan, so far, acknowledges this, and the facilities 

provided may still be useful in conditions that are not ideal.  

A number of predefined categories have been included with the installed version of 

Dietplan, mainly as examples of how they appear and work. The intention is for 

you to define and set up categories yourself, as you need them. You can delete all 

the existing examples if you wish; from the Admin menu, choose Food 

categories, then Delete all category definitions. The exceptions are the FVN and 

DFVN - [Dried] Fruit, Vegetables & Nuts - categories that are needed for the 

Nutrient Profiling Model for recipes.  

The initial declaration and setting up of category definitions requires system 

administration rights, which give you access to the Admin menu.  

The first stage is the allocation of a name, a (mnemonic) code and a type to each 

new category. A category can be one of three types: Computed, Declared or 

Private. A computed category also requires a definition of the logical rules of the 

underlying computation. From the Admin menu, choose Food categories, then 

Define dietary categories - see next section .  

In the second stage, declared and private category types require some or all of the 

foods in the database to be tagged as being included in, or specifically excluded 

from the category. From Admin | Food categories , select Foods in a specified 

category or Categories for a specific food. See Add categories to foods  

The third and final stage is to place an analysis into one or more of the defined 

categories. From the Tasks menu, select Dietary categories. See Add categories 

to analysis.  

8.15.2 Define dietary categories 
From the Admin menu, choose Food categories, then Define dietary categories  

Decide on a descriptive name for each new category, together with a brief and 

unique code. There is no restriction on the format or length of the code. Its 

purpose is to act as an abbreviation for the full name, so a mnemonic or acronym 

would be helpful but a long code would be self-defeating. Each category is also 

given a type, one of Computed, Declared or Private.  
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The Code and Category name columns of the entry grid contain editable fields 

where the values can be entered directly. On entry to the Type field, a drop-down 

selection list is available to select the appropriate type.  

Declared and Private types are very similar, in that they both require foods in the 

database to be tagged as being included in or excluded from that category. Both 

types appear in the list called up by the Category codes button on the Search 

foods panel, which means that either type can be used to list all the foods in that 

category. However recipes, menus and assessments can only be given categories 

that are Declared (or Computed) types. So while a Declared category needs to 

be something that is meaningful in which to put, say, a recipe, a Private category 

can contain any arbitrary set of foods you like. You can use it, for example to 

contain all high-energy food supplements so that they are all listed when you do a 

food search on that category, or you could use it just to group together, and return 

a list of all your favourite deserts.  

When you have defined a Computed category, the Define rule button is enabled 

whenever any of the cells in that row are in focus (highlighted with a thicker blue 

box). Click this to continue and define the computing rules.  
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Each rule is a series of statements of the form:  

Item Relation Value Join  

For example:  

Fat less than 15 AND 

Sat.fats less than 5  

Item is the name of a nutrient, selected from the drop-down list that appears 

when a cell in the column is activated. Relation can have the value less than, 

equal to or greater than, again selected from a drop-down list.  

Value is a numeric or symbolic value that is typed into the editable grid cell.  

Join can have the value AND or OR or <blank>, selected from a drop-down list.  

If there is more than one statement line, the Join operator shows how they are to 

be combined logically. The item on the last line is always blank.  

Value can be a simple number that is calculated as an absolute value e.g. fat less 

than 50 (grams - per portion), or it can be followed by % e.g. fat less than 5% 

(percentage weight). It can also be entered in the form Vxxx where V is the letter 

'V' and xxx is zero or more letters and/or numbers, used only for identification. In 

this last case, the actual numeric (or percentage) value is entered and saved when 

an analysis is put into this category. So a recipe that is a main dish, for example, 

can be given a value for, say, calories less than that is different from a recipe 

that is a desert. In other words, each analysis can hold its own, independent values 

for the same category definition.  
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The effect of the rule is that it must calculate out to be True for the analysis to 

which it is being applied, in order for the category itself to be declared true for that 

analysis.  

There is no restriction on the number of statement lines in the rule definition. To 

assist in editing the rule you can use any of the Clear, Insert row or Delete row 

buttons.  

8.15.3 Add categories to foods 
You can either pick a single category then add foods into it, or you can choose a 

single food then select the categories it belongs to.  

From the Admin menu, choose Food categories, then Add foods into a category  

 

In the panel labelled Select food source(s) and category you can tick all the food 

data sources to be categorised. Sources MW5, MW6, IDS and FAT do not appear 

because they are only aliases pointing to their real identities in UKN. Choose the 

category into which you are going to add foods from the drop-down list of 

Declared and Private categories.  

You do not need to flag every single food as being included in or excluded from a 

category. Each food can be in one of three states: Included, Excluded or 

Unknown. When a category is first defined, all the foods are, by default, in the 

Unknown state. Later, you can decide whether or not to raise a warning when 

unknown-state foods are added into an analysis with this category. In the Specify 

foods radio-box, select either to be included or to be excluded. You can have a 

mixture of both types saved for any category. Then, in the Display foods radio-box, 

select to have the foods displayed by food group, by name or by reference code. 

Displaying foods by group as in the example above, can make it easier in some 

cases to select a whole group or sub-group at a time by ticking the box further up 
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the hierarchy, which automatically selects all the items below. For example, in the 

illustration, all the foods in the groups Fruit, Herbs & spices, Nuts & seeds and 

Vegetables are all being included into the Vegetarian category by ticking each of 

the groups. Another example would be to excluded all Milk and milk products from 

the Lactose-free category.  

Whichever method you use to display them, proceed through the tree of foods and 

tick each group or individual food to be included/excluded for this category as 

appropriate.  

Click Save to update all the foods in the database with your selections.  

To add the categories for a specific food, from the Admin menu, choose Food 

categories, then Add categories to a food. 

 

With this option, select a specific food and, from the list of all the declared and 

private categories, tick the corresponding box to explicitly include or exclude the 

food, or leave both boxes blank to put the food into the unknown-state for that 

category. Click Save to update the database with your choices.  

Note that in both the above methods, it is not meaningful to exclude any food 

from a Private category, as this type of category is only ever used to produce a 

list of included items during a food search .  

8.15.4 Add categories to an analysis 
Categories can be added to an analysis in the Selection page of the analysis 

notebook.  

Click the button labelled Set up or Amend in the panel labelled Food (or Recipe) 

categories.  
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-or-  

From the Tasks menu, select Dietary categories  

 

A multiple-selection list of all the Computed and Declared categories allows you 

to select the one(s) that apply to this analysis. When a Computed category is 

highlighted, the Show rules button is active, and clicking it will display the 

definition. If the definition contains any values that are specific to the analysis, 

then if the category is selected another dialog appears in which the analysis-

specific value can be entered.  
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In the example above, the value of the amount of fat was set as Vxx when the rule 

was defined, meaning that the actual level is different for each individual analysis. 

So it is necessary now to enter the value for this specific one.  

 Enter values into all fields that are not read-only, that is, with a white background. 

Value can be a simple number that is calculated as an absolute value e.g. fat less 

than 3 (grams - per portion), or it can be followed by % e.g. fat less than 3% 

(percentage weight).  

Click OK when all required values have been supplied. These are saved with the 

individual analysis and are used to compute the state of the category whenever it 

is needed.  

You can set three types of warning to inform you, as you add foods and ingredients 

to the analysis, when category codes are not compliant. It is possible to set more 

than one type of warning.  

 Warn if adding the food will make the analysis fail a computed category, 

such as Low-calorie  

 Warn if a food is added that is explicitly excluded from a declared category.  
 Warn if the category of the added food is unknown.  

The effect of the last item is to permit only those foods that have been explicitly 

included in the category. You may not wish to set this warning level unless you 

have gone through the whole database and included all the qualifying foods.  

Note that setting the warnings will apply to all analyses that have had categories 

set. Your selections of warnings are stored and remain current until you change 

them, by re-opening this dialog from within any analysis. There is an option in 

your preferences to apply these warnings, or not, whenever an analysis is recalled 

from the database and first opened  

 



Dietplan7 User Guide 

 98 

9. Views 
9.1 Reports 

9.1.1 Create report 
Dietplan7 produces reports in portable document format (PDF), that can be both 

printed and saved, and the saved versions can be viewed using freely-available 

tools like Adobe Reader. Although the contents of PDF files can be altered using 

specialised software, they are much more secure from casual or inadvertent 

alteration than if saved in a proprietary word-processor format.  

Dietplan7 contains its own software for viewing and printing PDF reports. It can 

also recognise if Adobe Reader is installed (Windows only) and embeds Adobe 

Reader into the standard report-viewing page of each analysis. All versions of 

Adobe Reader are supported, from Version 5 through to the most recent, at the 

time of writing, Version 11. The most recent version is always is recommended and 

there is a copy that can be installed from the Dietplan7 distribution CD if you have 

permission to do so. You can switch between using Adobe Reader and the internal 

viewer using the Preferences option on the Edit menu.  

 

Every analysis notebook has a Report page as do a number of other types of 

notebook, such as the Composition of Foods and Recipe Summaries.  

To create a report for the current analysis, from the Views menu, select Create 

report  

-or-  

Click the Report button on the Composition page of the analysis  

-or-  

Click on the Report page tab of the analysis notebook  
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Above is an example report using the Dietplan internal viewer. Like Adobe Reader, 

the whole report can be viewed in a single scrolling window and there is a toolbar 

at the top of the window that performs a similar range of functions. From left to 

right, these are: Print, Save, First page, Previous page, Next page, Last page, 

Display/Enter page number in page range, Zoom out, Zoom in, Select zoom value, 

Fit page to width and Fit page to height.  

If you change your choice of viewer via Preferences , reports already opened are 

not affected by the change but all reports created subsequently will be displayed 

using your chosen viewer.  
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Above is an example of a report in Dietplan7 using Adobe Reader. You can navigate 

the pages and choose the magnification in a similar way to the internal viewer 

using the built-in toolbar.  

Outside the scrolled viewing window,the controls are common to both viewers. Use 

the Design button to open a report-definition dialog where you can set up a new, or 

recall an existing report definition.  

To save the contents of the report to a file :  

Click the Save button on the Report page  

-or-  

From the File menu, select Save  

-or-  

From the Dietplan or the viewer toolbar, click on the Save button  

-or-  

Press Ctrl and S 

You can choose or confirm the output file name and folder. By default, the file 

name will be the corresponding recipe, menu or registration code and have the 

extension .pdf . External viewers recognise and import .pdf files automatically, so 

the file extension should not be changed. By default the files are saved in the 

reports folder of your Dietplan7 work area, but you can change the folder using 

the Preferences option. 
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There is also a radio box where you can choose to save reports and graphics 

in Libre/Open Office (.odt) format. Libre Office and Open Office are free software 

packages very similar to pre-2007 editions of Microsoft Office. So, if reports are 

saved in this format, you can use Libre Office to load and customise them in the 

same way as any other word-processor document. Libre Office can then save 

documents in Microsoft Office (.doc) format and more recent versions of Microsoft 

Office can read Libre Office (.odt) format documents directly. 

To print the contents of the report :  

Click the Print button on the Report page  

-or-  

From the File menu, select Print  

-or-  

From the Dietplan or the viewer toolbar, click on the Print button  

-or-  

Press Ctrl and P  

Using either viewer, a printer dialog appears, from which you can choose the 

destination printer, the number of copies, and the range of pages you would like 

printed. The dialog that appears depends on the version of Windows you are 

running.  

The Refresh button is now obsolete. It was needed in earlier versions of Dietplan 

because changes made to an analysis did not automatically update a report that 

was already open. Such changes now do so, but the button has been retained for 

the time being.  

To return to the composition page of the analysis notebook, from the report page, 

click Back.  

9.1.2 Define report content 
The appearance and content of your reports can be defined and saved. You can 

save as many different definitions as you like and recall and use them as required.  

From the Views menu, select Define report  

-or-  

Click on the Design button on the Report page of the notebook  

-or-  

Press Ctrl and D  



Dietplan7 User Guide 

 102 

 

There is one pre-defined report definition, called Default. This shows as a System 

definition in the lower left corner of the dialog, indicating that it cannot be 

changed, although you can save alterations under a different name using the Save 

as button.  

Similarly, if individual user accounts have been set up, any definitions created by a 

system administrator, using the Define standard reports dialog on the Admin 

menu, will appear as Standard definitions which also cannot be changed but, like 

a system definition, can be copied using Save as. A definition that you create or 

copy and save with a name of your own appears as a User definition and it can 

be altered and edited as required.  

All saved system, standard and user definitions appear in the drop-down selection 

list of the Name of saved definition field.  

The left-hand panel of the dialog contains a tree of items that can be selected and 

defined. Highlighting an item brings up an associated set of fields in the right-hand 

panel that you can set up and alter, as required. In the example above, the Page 

numbers item is selected, and you can specify the format and location of the page 

numbering, and associated elements, in your report.  

The selection tree is has three main branches. The Layout branch contains items 

that affect the format and appearance of the report. The Content branch lets you 

select the items to be included in the report and the details of their appearance. 

The Aggregation branch is only enabled for reports that contain analysis groups, 

that is, menus and intake diary assessments. When active, you can select which 

days, meals and courses are to be reported and how they are to be combined. See: 

Selecting analysis groups. As the selections you can make in the aggregation 

branch depend on the structure of each individual analysis, they are not saved in 

the report definition but must be altered from the default selections as required; 

the selections you make are remembered for as long as the analysis is open.  
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The Content branch of the tree has a selection box beside each item and, when 

the box is ticked, that item will be included in the report. The first two items, Titles 

and Details are permanently ticked, but when you highlight either, you can choose 

the details to appear in these report sections.  

 

The first and second lines of the main title come from your Dietplan licence and 

cannot be changed. But you can use the selection boxes to choose whether or not 

to include them. You can also specify what sub-title appears for each type of 

analysis. If made blank, no sub-title appears for that analysis type.  
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Each report begins with a section containing the identifying details of the analysis 

together with other parameters. Each detail can be selected for inclusion, or can be 

omitted, by making the appropriate selections in the Details panel. Not every detail 

is applicable to all types of analysis and, if selected, will be ignored where they do 

not apply.  

Each of the other sections of the report can be selected or omitted as required. As 

each section is highlighted, the right-hand panel shows any variables that can be 

set or selected within the section. For example, if you include a table of the foods 

and ingredients in the analysis, you can specify how the list is sorted, and whether 

or not ingredient quantities are to be revealed.  
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Each of the graphs, which can also be viewed independently, can also be selected 

for inclusion in the report.  

 

The details of how to set up each type of graph are described in the sections on 

each individual graph type .  
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One other item that can be included in the report is a food-labelling section. This 

produces information in the format and using the nutrient and energy conversion 

factors specified in the EU regulations. The selection check-box for food labelling is 

only enabled when the current analysis is a recipe.  

 

You can choose to show just the mandatory items or include the optional macro 

nutrients together with a list a list of vitamins and minerals that have values 

greater than 15% of the N.R.V. You can also show the vitamins and minerals that 

have less than the significant 15% value.  

Click the Save button to store changes to any User definition. To save the changes 

to any definition under a new name, leaving the contents of the original intact, click 

Save as and supply a new name when requested.  

9.1.3 Selecting analysis groups 
Some types of analysis, that is, menus and intake diary assessments, require you 

to divide the analysis into a specified number of days, meals, courses and choices 

of dishes. These are referred to as analysis groups and the foods intended for, or 

consumed in each individual group are entered and stored separately within each 

group.  

When you create a report or a graph in an analysis containing groups, the 

Aggregation branch of the selection tree in the report or the graph definition 

dialog is active and the group types that have been defined can be highlighted. A 

selection dialog corresponding to the highlighted group is displayed in the right-

hand panel.  
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For each active level of grouping, you can specify the range to be included and 

whether individual members of the group are to be presented Individually or 

Aggregated. For example, you could choose to report Days 2 through to 4 

individually, and to aggregate all the meals each day, which would produce the 

separate nutrient intake for each of thee days.  

In the hierarchy of days, meals, courses and choices, if you choose to aggregate at 

a particular level then all the groups below that level are also, automatically, 

aggregated. For example, if you aggregate all the meals over a day, it is not then 

possible to report the courses or choices individually within each meal.  

In a menu analysis, if menu choices are permitted, two additional items are 

enabled in the aggregation branch: menu choices and menu servings. These are 

the same functions that are accessible through the Tasks menu, but they are also 

available here at the point of report or graph creation.  

There are more reporting options in the Choice range selection group than in the 

day, meal or course ranges.  

In addition to being able to report the choices individually or aggregated, you can 

report served proportions or selected choices, provided that the relevant servings 

or choices have been entered.  

9.1.4 View saved report 
After you have saved a Dietplan7 report as a PDF file, as well as being able to view 

the report using programs like Adobe Reader, either stand-alone or from inside 

your web-browser, you can also view it from within Dietplan itself.  

From the Views menu, select View saved report  

Choose the report from the Open file menu that appears, by default this shows 

the files in the reports folder of your Dietplan7 storage area, or the folder you 
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have chosen for saving reports by using the preferences option; but you can 

navigate to any other folder you wish.  

Once selected, the report is opened in its own single-page notebook, using your 

preferred report viewer.  

9.2 Graphs 

9.2.1 Show graphs 
Dietplan7 produces a number of types of graph that can be viewed on screen and, 

optionally, both printed and saved. The saved graphs can be viewed using your 

web-browser. You can also choose the same graphs for inclusion in a Dietplan 

report  

The content and appearance of your graphs can be defined and saved using a 

graph-definition dialog. You can save as many different definitions as you like and 

recall and use them as required.  

Every analysis notebook has a Graph page, as do other types of notebook, such as 

the Composition of Foods.  

Four types of graph are available:  

Nutrient weight profile  

Nutrient energy profile  

Nutrient sources  

Compliance with DRVs  

To create a graph for the current analysis:  

From the Views menu, select Show graphs then select the graph type you require 

from the sub-menu.  

-or-  

Click the Graph button on the Composition notebook page of the analysis  

-or-  

Click on the Graph page tab of the analysis notebook  

In the last two cases, the most recently selected graph type will be created 

immediately. Select a different type from the radio-box on the graph notebook 

page.  
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If the graph extends over more than one screen page, use the set of buttons to 

select the first, previous, next and last screens. Use the Design button to open a 

graph-definition dialog where you can select and save the appearance and content 

of the different graph types.  

The Refresh button is now obsolete. It was needed in earlier versions of Dietplan 

because changes made to an analysis were not automatically reflected in a graph 

that was already open. Such changes now update the graph automatically, but the 

button has been retained for the time being.  

To save a graph to a file:  

Click the Save button on the Graph page  

-or-  

From the File menu, select Save  

-or-  

From the toolbar, click on the Save button  

-or-  

Press Ctrl and S 

You can choose or confirm the output file name and folder. The graph will be saved 

in portable network graphics format, and by default, the file name will be the 

corresponding recipe, menu or registration code and have the extension .png . 

Web browsers and picture viewers recognise and display .png files automatically, 

so the file extension should not be changed. By default the files are saved in the 
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graphs folder of your Dietplan7 work area, but you can change the folder using 

the Preferences option.  

To print the graph:  

Click the Print button on the Graph page  

-or-  

From the File menu, select Print  

-or-  

From the toolbar, click on the Print button  

-or-  

Press Ctrl and P 

The displayed graph is converted into PDF format and printed. At the moment it 

simply formats the graph to fill a complete A4 page and is preceded by a printer-

selection dialog.  

9.2.2 Define graphs 
The appearance and content of your graphs can be defined and saved. You can 

save as many different definitions as you like and recall and use them as required.  

From the Views menu, select Define graphs  

-or-  

Click on the Design button on the Graph page of the notebook  

There is one pre-defined report definition built into Dietplan, called Default. This 

shows as a System definition in the lower left corner of the dialog, indicating that 

it cannot be changed, although you can save alterations under a different name 

using the Save as button.  

Similarly, if user accounts have been set up, any definitions created by a system 

administrator, using the Define standard graphs dialog on the Admin menu, will 

appear as Standard definitions which also cannot be changed but, like a system 

definition, can be copied using Save as. A definition that you create or copy and 

save with a name of your own appears as a User definition and it can be altered 

and edited as required.  

All saved system, standard and user definitions appear in the drop-down selection 

list of the Name of saved definition field.  

The left-hand panel of the dialog contains a tree of items that can be selected and 

defined. Highlighting an item brings up an associated set of fields in the right-hand 

panel that you can set up and alter, as you require.  

The selection tree is divided into three main branches. The Appearance branch 

contains items that affect the format and appearance of the graphs. Currently the 

only items in this branch allow the background colour of each type of graph to be 

individually changed from it's default sky-blue to white - potentially saving ink if 

the graph is printed. The Content branch lets you select the items to be included 

in the report and the details of their appearance. The Aggregation branch is only 

enabled for items that contain analysis groups, that is, menus and intake diary 
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assessments. When active, you can select which days, meals and courses are to be 

included and how they are to be combined. See: Selecting analysis groups. As the 

selections made in the aggregation branch depend on the structure of each 

individual analysis, they are not saved with the graph definition but must be 

altered from the default selections as required; the selections you make are 

remembered for as long as the analysis is open.  

The Content branch of the tree has a selection box beside each graph type and, 

when the box is ticked, that type of graph will be created. Only one type can be 

selected at a time, although the set up details for a graph can be displayed in the 

right-hand pane and altered without actually selecting the graph itself. The details 

of how to set up each type of graph are described in the sections on each individual 

graph type.  

Click the Save button to store changes to any User definition. To save the changes 

to any definition under a new name, leaving the contents of the original intact, click 

Save as and supply a new name when requested.  

9.2.3 Graph nutrient contribution by weight 
Shows the contribution to total weight of each of the macro-nutrients: protein, fat, 

carbohydrate, alcohol, water etc.  

 

You can choose the Graph type to be Bar graph, Histogram or Pie chart. With a pie 

chart or a histogram, you can choose Display details, and either show just the basic 

protein, fat, CHO and alcohol or include the details of sugar, starch and the 

different types of fat.  

If your analysis includes information by portion or by day, meal or course, you can 

set the Quantities reported to either the total or the average value of any of these. 

When the subject of the graph has a high water content, it can dominate a bar 

graph or histogram making it difficult to see the contributions of the other 
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nutrients. There is also the option to suppress the scaling of any nutrient that is 

more than N times higher than any other. You can set the value of N, which has a 

default value of 4. Setting N to zero prevents any suppression. The effect of this 

can be seen below : 

 

The water content is more than 70% compared to the next highest contribution, 

from sugars, of less than 8%. But because the water is not drawn to scale, the 

contribution of the other nutrients can be seen clearly. 

9.2.4 Graph energy contributions 
Shows the contribution to total energy from protein, fat, carbohydrate and alcohol 

using the currently defined set of energy conversion factors.  
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You can choose the Graph type to be Bar graph, Histogram or Pie chart. With a pie 

chart or a histogram, you can choose Display details, and either show just the basic 

protein, fat, CHO and alcohol or include the details of sugar, starch and the 

different types of fat.  

If your analysis includes information by portion or by day, meal or course, you can 

set the Quantities reported to either the total or the average value of any of these.  
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9.2.5 Graph sources of a nutrient 
Choose any nutrient from your current selection list and produce a graph showing 

the percentage contribution of each food or group of foods in the analysis to the 

nutrient total.  
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You can choose the Graph type to be Bar graph, Histogram or Pie chart.  

Select the required Nutrient from the drop-down list that contains your current 

selection of nutrients.  

Use the Food group field to report the percentage nutrient content for each 

Individual food in the analysis, or to group foods together using the three letter 

food group codes used in the UK food tables. You can group the foods at Level 1, 

Level 2, or Level 3 that is, use one, two or three letters of the hierarchical group 

code. For example, a level 3 group code is BTQ, Low fat spreads whereas at level 2 

it would be contained in the group BT, Butter & related fats while at level 1 it 

would be part of B, Milk & milk products.  

The nutrient contributions can be sorted in ascending or descending order of 

quantity, or in order of food/group code or food/group name. You can also specify 

a lower or an upper cut-off threshold as a percentage below / above which foods or 

groups are omitted from the graph.  

If your analysis includes information by portion or by day, meal or course, you can 

set the Quantities reported to either the total or the average value of any of these. 

 

9.2.6 Graph actual v recommended intake 
For each selected nutrient in the analysis, the graph shows the actual quantity of 

the nutrient as a percentage of the dietary reference value.  

This graph can only be produced if DRVs have been specified for the analysis. If 

this has not yet been done, from the Tasks menu, select Dietary reference values. 

See Using dietary reference values.  
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Not all nutrients have a dietary reference value, any missing are omitted from the 

graph.  

 

You can choose the Graph type to be a Bar graph or a Histogram. A pie chart is not 

possible for this type of graph. Select the required DRV to display from RNI, EAR or 

LRNI and, and, if possible, set the Quantities reported to per day. As DRVs are 

defined as a daily-recommended intake, selecting any other reporting quantity is 

not meaningful. 
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9.3 Grids 

9.3.1 Show grid 
It is possible to produce a grid view of any analysis, which is a spreadsheet-style 

view showing all the foods (rows) against all the current selected set of nutrients 

(columns).  

From the Views menu, select Spreadsheet grid  

-or-  

Click the Grid button on the Composition notebook page of the analysis  

-or-  

Click on the Grid page tab of the analysis notebook  
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The grid is displayed in a scrolling window on the analysis grid page. You can re-

size or maximise the main Dietplan window to show as much of the grid as 

possible. The grid itself has a light yellow background, indicating that all the 

information is read-only. 

Click any column-heading to sort the grid in the order of that column. Click again 

to sort in reverse order.  

Click the Export button to write the contents of the grid to a comma separated 

value (csv) file that can be imported by spreadsheet or statistical analysis software. 

By default, fields containing nutrient values are formatted as when they appear on 

the corresponding Composition page of each analysis. That is, zero values show 

as Nil, missing values as --- and other values may be non-numeric or have a non-

numeric suffix. If you require that only numeric nutrient values are exported, select 

Exported nutrients to contain only numeric values in the Spreadsheet export tab of 

Edit | Preferences. 

The Print button can be used to obtain a hard-copy printout of the grid. It is 

produced in a number of sections and on multiple pages if necessary.  

9.4 Queries 

9.4.1 Create lists 
Lists are created by running queries on the Dietplan7 database. The procedure for 

creating them is similar for each type of list.  

From the Views menu, select Lists and from the sub-menu, choose one of  

Foods, Recipes, Menus, Registrations or Assessments  

Select the type of list you require from the items in the chosen sub-menu  

For foods you can produce lists  
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o by name  

o by reference code  

o by food group code  
o by food category  

The lists in this sub-menu can also be called directly from the main Foods menu  

For recipes and menus, you can produce lists  

o by name  

o by reference code  

For registrations and assessments, you can produce lists  

o by surname  
o by registration number  

Selecting a list of any type opens a notebook containing two pages, labelled 

Selection and Listing.  

 

For food lists only, you can select which food sources are to be included; tick the 

checkbox for each data source that you want to include in the list. By default, all 

lists will contain the full range of qualifying items but you can use the Begin with 

and End with fields to restrict that range by entering starting and/or ending values 

for the attribute the list is being produced by. If the list is by reference code, enter 

the reference code(s) where the list is to begin and/or end. Similarly if the list is by 

name, enter suitable values for either or both ends. For example apples and pears 

will list all the foods with names beginning alphabetically between these two 

values.  
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When all your criteria have been entered, click Continue. The list will be created 

and displayed in the Listing page of the notebook. You can tab back and forth 

between the two pages, amending the criteria as necessary.  

 

The list is displayed in a scrolling window and the number of items in the list is 

displayed below, alongside four action buttons. The list is presented in the 

requested order, but can be re-ordered on any column by clicking on the title of the 

column. A second click on the same column label will reverse the sort order.  

As data sources MW5, MW6, IDS and FAT are sub-sets of the complete UKN 

table, if the list criteria include more than one of these sources, the resulting list 

will probably contain duplicates.  

Click Save to bring up a file selection dialog to specify the name of a text file 

where the list, as seen, will be saved. Click Print to send the text of the list to a 

printer. Back will return to the Selection page of the notebook, and Close will 

shut the list notebook.  

9.4.2 MW7 publication numbers 
The complete set of foods in the UK nutrient databank is contained in the range of 

food reference codes between 11-001 and 50-1188. Historically these derived from 

the 5th edition of The Composition of Foods together with all the published 

supplements. Each supplement was given a prefix, beginning with 11- for Cereals 

and Cereal Products, and ending with 19- for Meat Products and Dishes. Adding the 

prefix 50- to the range of 5th edition food codes completed the set.  

In Dietplan, this complete set of UK foods has UKN as its data source mnemonic 

code although, by default, this set is not visible as it contains all the foods ever 

published, from the 5th edition to date, including all the now obsolete foods. To see 

the full UKN set, select Include all archived UK foods on the Admin menu. The 
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data set ID2 uses the same food codes as UKN but contains only the current set of 

UK foods.  

The foods in the published 7th summary edition of The Composition of Foods are all 

contained in the UKN and ID2 data sets, but they also have a sequential 

publication number, beginning with 1, in the order they appear in the 

printed publication. In Dietplan, you can reference foods from the 7th edition, using 

the publication number, by using the data source code MW7 .  

To see a cross-reference of the publication codes with the corresponding codes in 

the UKN/ID2 datasets, from the Views menu, select MW7 publication numbers  

   

This produces a listing of the selected set of publication numbers inside a scrolling 

window, together with a count of the number of items in the list. The list is in 

publication number order, but can be re-ordered on any column by clicking on the 

title of the column. A second click on the same column label will reverse the sort 

order.  

Click Save to bring up a file selection dialog to specify the name of a text file 

where the list, as seen, will be saved. Click Print to send the text of the list to a 

printer and Close to dismiss the list  

 



Dietplan7 User Guide 

 122 

10. Data 
10.1 Add or Edit USF food 
To add a new USF food, from the Data menu, select Add USF food.  

or 

To edit an existing USF food, from the Data menu, select Edit USF food.  

Foods can be added locally into the database and are allocated the data source 

code USF (user added food). However, if your installation of Dietplan has been 

configured with individual user accounts, a user with Administrator privileges and 

access the Admin menu can remove or restrict your access to this option. If the 

option is removed, and only administrator added ADF foods are permitted, the 

menu option will be disabled. If access is restricted you will be able to see and use 

USF foods you have added yourself but not those added by other users. If access 

is not restricted you can use, and alter, foods added by other users but in the same 

way they can use and alter foods that you yourself have added.  

 

  

You can use any food codes you wish within the USF group. It can contain letters, 

numbers and other punctuation characters and be up to 16 characters long. If you 

are not concerned about the value of the code you can let the software allocate one 

for you: leave the Ref code field blank, click Accept and the next available code in 

the sequence beginning F00001 will be used.   

You cannot alter any foods that have data-source codes other than USF but you 

can make a copy of any food then edit and save it as you wish. To base your 

USF on an existing food in the database, click Copy from and identify or search for 

the food you want to use as a model. The nutrient details of this food are copied 
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into the new food and you can then amend them as you wish. Add or edit the 

Name of the food and the optional Description and Notes. Use the drop-down list to 

select a suitable Food group . 

The Declared allergens, Portion sizes and Defined nutrients fields will be empty 

initially or will contain values from the food you have copied. To add or amend 

values, click the corresponding Edit button. 

 

  

Each of the 14 allergens can be declared Yes or No or  left as --- (not known) via 

the drop-down selection box beside each one. Click OK when finished to return to 

the original Selection page. 

The page for adding or altering porion sizes is identical to the one used by the food 

portion sizes option on the Admin menu 
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The Nutrients page contains a radio box that switches the nutrient input panel 

between the set of food-label nutrients (the default), your currently selected 

nutrient list and all the available nutrients. Via your currently selected nutrient 

list you can tailor both the number and the order of the nutrients to be input 

and you can set up and recall different lists by using the Select nutrients button or 

menu item. 

When the food is first created and is not based on an existing food, all its nutrients 

are initialised to missing value, indicated by three dashes ( --- ). You need only 

enter values for the nutrients you want, but some simple checking is done to 

ensure that the values are consistent. Click on or use the cursor Up and Down 

keys to highlight each required nutrient in turn, and enter the quantity of that 

nutrient contained in 100 grams of the food in the units shown. If you want to 

enter the nutrient quantities relative to any quantity other than per 100 grams, 

enter that quantity in the Input nutrients per ___ grams of food field. The amounts 

you enter will be converted to the equivalent amounts per 100 grams of food 

before being saved.  

You can add various qualifying codes to the numerical values. Append a d to 

indicate the nutrient has been computed by a derived or difference method, or 

append an e if the value is an estimate. Use 0+ to show that traces of a nutrient 

are present and ++ if it is present in significant but unknown amounts. If a 

nutrient value is missing or unknown, use a blank or dashes --- to show this. Only 

enter 0 or 0.0 if the amount of the nutrient really is zero. Click OK when finished 

to return to the original Selection page  

When all the required allergen, portion and nutrient values have been supplied, 

click Save  on the Selection page. The food is added to or altered in the database 

and is immediately available for use. If a food is edited that is already being used 

in any analysis, when that analysis is next opened, a warning will be given that the 

food has changed. This will recur until the analysis itself is resaved, effectively 

accepting the change.  

To delete an added food, recall it using the Edit USF food option and, from the 

File menu, select Delete. A warning message will be displayed if the food is being 

used in any analysis in the database. You can still continue and delete the food but 

then, when any such analysis is recalled it will warn that one of its ingredients is 

missing.  

You can also delete one or more user-added foods in a single operation using the 

Delete Dietplan records option on the Admin menu, although in that option, no 

checks are currently made whether the deleted foods are being used.  

10.2 Export database records 
From the Data menu, select . 

This performs the same functions as Export Dietplan records on the Admin menu 

but, unlike that item, which requires System Administrator rights, this one is 

available to all users.  

10.3 Import database records 
From the Data menu, select Import database records. 

This performs the same functions as Import Dietplan records on the Admin menu 

but, unlike that item, which requires System Administrator rights, this one is 
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available to all users. If your assigned privileges do not permit writing to the main, 

shared database, the records you import will be saved in your private database 

partition.  

10.4 Search analyses for a food item 
From the Data menu, select Search analyses for a food item. 

This will search through your saved analyses and report which ones contain the 

specified food or ingredient. The type of analysis searched is the current selection 

of recipes, menus or assessments. 

 

Enter the data source and food code of the food or ingredient to be found or click 

Browse to search and select the food by name. If the food also appears with a 

different food code in another data source, for example it appears in both ID2 and 

MW7 you can select if all its aliases are to be included in the search. Similarly, the 

food might have been used in one or more recipes that are subsequently included 

in menus or food diaries so a preliminary search is done for the food in all recipes - 

plus recipes that in turn contain those recipes. A list of all such recipes is displayed 

and you can choose whether they are also to be included in the search. The results 

of the search are displayed on a separate notebook page when the Search button 

is clicked. 



Dietplan7 User Guide 

 126 

 

 



Dietplan7 User Guide 

 127 

11. Other options 
11.1 Setting your preferences 
From the Edit menu, select Preferences  

Many settings can be made that affect the behaviour of Dietplan. Your choices take 

immediate effect and remain in force until changed. However, unless individual 

user accounts have been set up, someone else using the program might also 

change them.  

A dialog appears, containing a selection tree on the left and a panel with various 

selectable fields on the right. The panel changes according to the item currently 

highlighted in the selection tree. The items on each panel are described below. To 

record a preference, click on the appropriate item in the selection tree and make 

your changes to the item(s) in the corresponding panel. Click OK to save your 

selections and dismiss the dialog.  

If you click the Reset button, the fields in all the panels will be set to the default 

values that were set when Dietplan was first installed and these will be saved as 

your current preferences when you click OK. This will also reset the saved sizes and 

positions of your main window and all the pop-up dialogs back to their original, 

default settings.  

11.1.1 Appearance preferences 

 

The only appearance that can be changed at present is the location of the tabs of 

the main workbook containing all the analyses and activities currently open. By 

default they appear along the top of the workbook screen area but you can choose 

to place them along the bottom. 
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11.1.2 Behaviour preferences 

   

With the publication of McCance & Widdowson's 7th edition (MW7) and the 

revised Composition of Foods Integrated Dataset (ID2) these are the only two UK 

data sources available by default and they only contain the most recent foods. So 

unless you have chosen to Include all archived UK foods on the Admin menu, the 

first two preferences are not applicable. If you have included foods from the older 

data sources, MW5, MW6, IDS and UKN, you can define what happens when you 

enter one of the older foods into an analysis by setting the Use most recent food 

code field to Never, Ask first, or Always. Also, if you check the Suppress duplicate 

foods from lists box, only the most recent version of each food will appear in your 

food search-lists - there are foods in these older datasets that do not appear 

in later tables.  

If Offer update if old foods found in recipes & menus is selected, when a recipe or 

menu is opened which contains one or more older foods you are asked if you wish 

to replace them with the most recent datasource and foodcode. This is in addition 

to Update foods in analyses on the Admin menu where you can replace old foods 

in any or all recipes, menus or assessments.  

When Show all words found during search is selected, a window displays the 

unique words from all the foods found during the search. You can click on individual 

words to include or exclude them and repeat the search.  

As a check against errors in data entry, different food groups have been assigned 

maximum values for the quantities that would reasonably be consumed or 

contained in a portion. If Check entered quantities against max for food type is 

selected, a warning is given if a larger quantity is entered.   

If Auto-save is ticked than each analysis is automatically saved to the database 

every time a food or ingredient is added or altered.  

When displaying and reporting the values of nutrients, you can choose the units of 

inorganic minerals to be presented in either metric (milligram) or S.I. (millimol) 

units  



Dietplan7 User Guide 

 129 

11.1.3 Information preferences 

   

Confirm assessment type when creating can be selected to ask for confirmation of 

the type of assessment (averaged or diary) being created immediately before 

the choice becomes irreversible.  

If you have set up dietary categories for an analysis, you will receive a warning 

when you add foods or ingredients that cause the analysis to fail the criteria for 

any of the categories, although you can ignore the warning and continue. If you 

would like to be informed, on recalling a saved analysis, that it is failing to comply 

with one or more of its categories, tick Display category warnings when analysis 

opened .  

Similarly, if you would like to know if any of the foods or ingredients in an analysis 

have been altered since it was last saved - for example, an ingredient might be 

another recipe that has been changed - tick Warn if analysis ingredient values have 

changed to be informed the next time it is opened.  

When you save an analysis into the database, select Show confirmation after 

analysis saved to receive a message that the save has been successful, otherwise 

the save is performed silently.  

11.1.4 Auto-backup on exit 
  You can use this option to make a complete backup of the Dietplan7 database 

automatically every time you shut down the program. The backup is made in the 

form of a compressed Zip file that can be restored using the normal restore 

function on the Admin menu.  
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If you are running Dietplan from a USB flash drive (Dietplan Portable) the default 

location for the backup is in the folder Dietplan7-backups in your Home folder on 

the hosting computer.  

 

If Dietplan is installed on your local hard drive, you can specify the backup location, 

which should be anywhere but the local drive, that is, on a removable drive or a 

USB memory stick.  

In both cases you can also specify how many backups are kept before the oldest 

one is deleted automatically .  
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11.1.5 Background image 

 

When there are no open notebooks containing analyses or other Dietplan functions, 

the large right-hand area of the main window is empty. Instead of displaying a 

blank white space you can use this option to select either an image or a plain 

colour to show.  

If you select Choose an image file you can select one of the .jpg files from the 

folder /resource/image in the main Dietplan7 installation folder or you can select 

any .jpg image file of your own to display.  

Alternatively you can Select a plain colour and use Choose to pick one or you can 

Use default image to display the image file default.jpg 

11.1.6 Current privileges 

 

If individual user accounts and profiles have been set up by a system administrator 

for your installation of Dietplan, you can use this function to remove or restore any 

of your own privileges up to the level originally granted during user registration.  
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So, for example, if you have permission to save data in the main, shared database, 

you can turn this off in order to save instead to your own, personal, unshared 

database area.  

11.1.7 Default settings 

 

You can define the default values of certain items using the fields in this panel. The 

default values are used as the initial values of the items when a new analysis is 

created. Within each new analysis you can then alter the initial values as you wish.  

For example, if you mostly carry out five-day assessments using RNI dietary 

reference values, you can set the defaults to reflect this. Then, whenever you 

create a new assessment, the values for these items will already be correct most of 

the time. In cases where the values do not apply, you can alter the assessment 

values to suit.  

11.1.8 Energy conversion factors 
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Within the UK nutrient database you can alter the setting of the Value source field 

to use either the energy values from The Composition of Foods or those specified in 

EU regulation 1169/2011.The differences are in the way protein, carbohydrate and 

energy values are defined. The individual values themselves are all available 

separately, so either type, or both, can be selected for inclusion in your analyses, 

using the Select nutrients option. The selection you make here is only to specify 

which set of conversion factors is used to compute the energy profile.  

You can set the Units for energy profile to either kiloCalories or kiloJoules. The 

conversion factors (Energy per gram) of protein, fat, carbohydrate, alcohol and 

fibre can be specified individually. Edit the numeric value you wish to use for each 

field in turn. The energy profile will be calculated using these factors. Note that if 

you then alter the settings of either the Value source or the Units for energy profile 

fields, the conversion factors will revert to the default values corresponding to 

those selections, replacing any individual values you have entered.  

11.1.9 Multiple view 

 

Although you can have many analyses open at the same time, they are displayed 

in different notebook pages and cannot be viewed simultaneously. To assist the 

comparison of analysis contents, reports, graphs or grids, you can use this option 

to temporarily display analysis pages side by side or one above the other. 

Afterwards you can revert to the normal display mode by selecting View 

individually.  
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11.1.10 Output folders 

 

By default, when you save information into individual files, they are saved in a sub-

folder of your Home directory called Dietplan7. Files of different types have their 

own sub-folders called reports, graphs, csvexports and textfiles . If individual 

user accounts have been created, it is possible that your local system manager has 

set up different locations, which you will see in the Preferences dialog.  

You can use the fields in this panel to specify or browse for alternative locations to 

save these files. You can keep the file types separate or direct them all into a 

common folder. You can specify or create these anywhere on your system where 

you have access.  

11.1.11 Report viewer 

 

The PDF files used to create reports can be previewed using the built-in PDF 

viewer. If you have the free Adobe Reader installed on your computer (Windows 

only), you can use this panel to choose which of the two viewers to use.  
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11.1.12 Retained history 

 

You can quickly recall any of the analyses that you have used recently by selecting 

them from the Most recently used list of items at the end of the main File menu. 

The default number of items is 5 but you can change this to any number between 1 

and 16.  

Similarly, when searching for foods, the criteria you have used in the most recent 

searches can be recalled from a drop-down list. The default number of items is 16 

but you can change this to any number between 1 and 32.  

You can also use the Delete current history button to remove the current 

contents of both the above lists .  

11.1.13 Salt equivalent 

 

When salt equivalent is selected as a nutrient for display and no value has been 

explicitly provided, it is calculated from the actual sodium (Na) content using a 
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conversion factor based on the ratio of the molecular weights of sodium chloride 

and sodium. This factor is 2.5445 and is the value used by default in Dietplan.  

Some prefer to accept a simpler conversion and use the value of 2.5. You can use 

this option to set your own preferred conversion factor and any value between 2.4 

and 2.6 will be accepted.  

11.1.14 Spreadsheet export 

 

Select the first option if you require the exported nutrient values to contain only 

numeric values with no associated text.  

The remainder provide various options for repeating certain fields in each row that 

is output.  

11.1.15 Update Checking 

 

In addition to explicitly checking for available updates to Dietplan using Check for 

updates on the Help menu, you can set up an automatic check when Dietplan 
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starts running. The default setting is Never but you can also choose Daily, Weekly, 

or Monthly checks.  

If an update is found you are informed and have the choice of installing or 

deferring the update. 

11.2 User feedback 
From the Help menu, select Submit problem or query  

 

This option enables you to supply details of any problem, query or suggestion 

about any aspect of Dietplan7 and its operation. The dialog already contains some 

basic information about your own copy of Dietplan. You are asked to enter your 

own name and contact details.  

If you are creating the report as a result of an error while running the program, 

details of the location and cause will have appeared in a pop-up window entitled 

Dietplan7 messages and errors. If you create this report while that window is 

still in view, the contents of the window, describing the error, will be inserted 

automatically into the report.  
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Enter any text you wish in the space indicated. You can use the cursor keys to 

move around the form and the usual edit keys to make corrections. When you 

reach the bottom of the space on screen, the window will scroll to allow you to 

continue typing.  

Click Send via email to transmit the contents directly to Forestfield Software. 

Alternatively, use Copy to clipboard to make a copy of the contents that can be 

pasted into any other document or file you wish, or Print hard copy to produce a 

copy for your records or to fax or post to the address in the report heading.  
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12. System Administration 
12.1 Import food tables 
From the Admin menu, select Import food tables  

In addition to the set of UK food tables (McCance & Widdowson) that was licenced 

with the purchase of your copy of Dietplan7, you can also import food tables from 

other sources. These are not loaded into your main database by default but can be 

selected and imported from special database files that contains them. The 

additional food tables contain food and product data from the following sources:  

UK supplier product tables  

o ABT Abbott Nutrition *  

o BKS Brakes * 

o DBN Danone Baby Nutrition 

o FRS Fresenius Kabi Ltd * 

o MJN Mead Johnson Nutrition * 

o NCC Nutricia Advanced Medical Nutrition * 

o NES Nestlé Health Science *  

o PSC Pepsico International *  

o SAF South Asian cooked foods  
o TVF Tillery Valley Foods * 

Other national food tables  

o FLV USDA Flavonoid data *  

o IFL USDA Isoflavone data  

o IRL Irish Food Composition Database *  

o N10Australia/New Zealand NUTTAB 2010 
o USD U.S.Dept of Agriculture SR 27 2014 * 

* Updated in Dietplan7 

The 3-letter code that precedes each item is the data-source code that is used to 

access that food table after it has been imported. 

The best way to obtain the tables is via the web, which ensures that you receive 

the latest versions of the tables. They are also available on the most recent 

Dietplan7 installation/upgrade CD that you have, but they will be the versions that 

were available at the time the CD was created. 
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Select either Web download or Local (CD) file. From the web you can choose 

either UK supplier product tables or Other national food tables and the appropriate 

file will be downloaded in encrypted form to a temporary location. The tables 

contained in that file will be displayed and you can choose to import any or all of 

them. Downloading and decoding the file may take half a minute or so depending 

on your connection speed and a progress bar is displayed while this happens. 

To import food tables from the Dietplan7 installation CD, insert it and cancel the 

Dietplan7 installation wizard if it starts automatically. From the screen above, with 

Local (CD) file selected, click Browse and, navigate to the plusfoods folder on 

the CD and select either dp70additional.sl3 or dp70national.sl3 for the UK supplier 

or the other national tables respectively. 

Select the table(s) you want to import by ticking the box beside each item or use 

the Select all and Deselect all buttons as required, then click the Import button. 

The selected tables are then loaded into the Dietplan7 database while a progress 

indicator is displayed. They will then be available from the main database using 

their respective data source codes, which will now appear in all food-selection 

screens and dialogs. If you used the CD, it can now be removed 

12.2 Remove food tables 
From the Admin menu, select Remove food tables  

This option can be used to remove any or all food tables previously inported with 

the Import food tables option.  



Dietplan7 User Guide 

 141 

 

All currently imported tables are displayed, each with a check box. Tick any tables 

you wish to delete and click Remove. A warning is given if you select a table 

containing foods that are being used in any recipe, menu or assessment and you 

can veto or continue with its removal.  

12.3 Include all archived UK foods 
From the Admin menu select Include all archived UK foods 

By default the Dietplan7 database only displays foods from the most recent sets of 

food tables, namely McCance & Widdowson's 7th Edition of The Composition of 

Foods (MW7) and the revised Composition of Foods Integrated Dataset (ID2). 

Foods from earlier datasets, those with data source codes MW5, MW6, FAT, IDS 

and UKN do not appear in the set of food tables available for selection although any 

recipes, menus or food diaries and assessments that contain these foods will use 

them normally as with any other selectable food. 

 

If you would like these older foods to be available for selection and use, select this 

menu option and confirm the message above. After a short delay while all the 

archived foods in the database are flagged as available, the above data source 

codes will then appear in the set of codes that can be selected when searching for 
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foods and a tick or checkmark appears beside the Include all archived UK foods 

item in the menu. If you select the menu item again, then access to the archived 

food is reset and the checkmark is removed. Any archived foods added into 

recipes, menus or food diaries and assesssments while they are available will 

remain unchanged. 

 

12.4 Add or edit foods in database 
Any user can add or edit their own foods in the database and they are given the 

data source code USF (User added food). From the  Data menu, choose Add USF 

food or Edit USF food. On a system where multiple users are registered, these 

functions may have been disabled by an administrator, see below.   

 If user accounts have been set up, users with System Administrator privileges can 

use the Admin menu in which the item Admin owned ADF foods is enabled, 

leading to two sub-items Add ADF food and Edit ADF food, the difference being that 

here foods are given the data source code ADF (Administrator added food) and 

they cannot be altered by non-admin users.   

The Admin menu also contains two other related items: Restrict USF food 

access allows users only to create, alter and use their own foods but not those of 

other users while Disable USF food access prevents users from creating or using 

any USF foods at all so the only foods that can be added or used are adminitrator 

added ADF foods.  

The processes of adding and editing foods are identical for both USF and ADF foods 

and they are detailed in the section Add or Edit USF food    

12.5 Food portion sizes 
From the Admin menu, select Food portion sizes  

The database can store an unlimited number of different portion sizes for each food 

and, when the food is selected for inclusion in an analysis, you can choose any of 

the portion sizes that have been defined. You can also specify the number of units 

of that portion, for example, 3 large slices [of bread].  

The database already contains portion sizes from Food Portion Sizes (MAFF, 3rd Ed. 

2002. HMSO with permission) for many of the UK foods. You can use this option to 

amend any of these or to add any others you need.  
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Specify the Source and the Reference code of the food you require, or click 

Browse and identify the food using any of the standard food search methods. If 

any sizes are already defined, the portion names and quantities are displayed. To 

add a new portion size or to alter or delete an existing one, click the Edit button.  
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An unlimited number of different portion names and sizes can be saved for any 

food. The upper scrolling window displays approximately 50 pre-defined portion 

names against any of which you can add, alter or remove the portion size in 

grams. The lower scrolling window allows you to add portion names of your own for 

this food, and to specify the associated portion sizes. The saved set of portion sizes 

is the combination of names and sizes from the two windows.  

When editing is complete, click OK to see the new set of portion sizes in the initial 

dialog. Click Save in this dialog to record your changes. 

12.6 Food input units 
From the Admin menu, select Food input units  

Food and ingredient quantities are added into an analysis in gram weight by default 

and there are several other pre-defined units. You can switch between these units 

for data input at any time while adding foods and ingredients into an analysis. The 

default units can be chosen in your preferences. With this option you can declare 

additional food units to be included in the list of choices of units. You can also 

remove any of the existing definitions, except gram and ml. The new units, like 

the others, are for input only. All quantities are converted into and stored in grams 

and all output is in metric units.  

 

  

The dialog allows you to name the Unit and to specify the Grams per unit 

conversion factor to be used. That is, the conversion must be specified as the 

number of grams corresponding to one of the units being defined. Existing pre-

defined input units that cannot be altered are shown with a yellow background.  
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You must also specify the Unit type of the item you are entering by selecting 

whether it is a weight or a volume unit. Volume units require the value of the 

Specific Gravity (SG), which is one of the 'nutrients' associated with each food. If a 

particular food, that you want to add by volume, does not have a value for the 

specific gravity, you can add it to the food yourself.  

You can also select the action when using a volume unit and food has no SG 

defined, by choosing between Ignore, Warn and Fail. If you choose Ignore then 

specific gravity of 1.0 is used to calculate the equivalent number of grams.  

Click Save to confirm your additions. Once defined, the new units are immediately 

available for use. 

12.7 Define new nutrients 
From the Admin menu, choose Food nutrients & allergens  then select Define 

new nutrients  

The database contains the definitions of around 350 constituent nutrients, although 

not all of these have values for every food. The full set of nutrient names can be 

seen in the Select nutrients dialog. In addition to these, you can define and 

activate new nutrients of your own and add values for them to any food in the 

database.  

 

  

Any new nutrients already defined will appear in the drop-down list of the Select 

nutrient field and they can be selected in order to edit their properties. The list also 

contains a <New nutrient> item, which should be selected to create a new 

nutrient.  
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Enter the Full name of the nutrient that will appear in reports, a Short name of up 

to 16 characters for display screens and an Abbreviation of up to 9 characters for 

column headings in graphs and tables. Select the appropriate Units for the nutrient 

from the drop-down list and the number of Decimal places that will be used to 

display the nutrient values.  

You can also add a free-text comment that will appear in the Notes field of the 

composition of foods notebook of any food that contains the nutrient  

Click Save to activate the nutrient. It can now be added to the current set of 

nutrients just like any other using Select Nutrients. But first you must add values of 

the nutrient to foods in the database  

To delete an added nutrient, recall it as above and, from the File menu, select 

Delete. A warning message will be displayed if the nutrient is being used in any 

food in the database. You can continue and delete the nutrient but all the nutrient 

values that have been added to foods will also be deleted.  

12.8 Add nutrients & allergens to a food 
From the Admin menu, choose Food nutrients & allergens then select 

Add nutrients & allergens to food  

 

This procedure is the same as editing a user added food except you can modify any 

food in the database as well as your own added foods. However, only your own 

nutrient definition(s) and the food's Specific Gravity, Free Sugars and Non-milk 

extrinsic sugars appear in the nutrient list for adding or altering. 

12.9 Standard nutrient lists 
From the Admin menu, choose Standard nutrient lists  
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This function is identical in behaviour to the Select nutrients for display function 

that can be called from the Tasks menu by any user. It is used to create or recall a 

list that specifies the nutrients to be shown in every recipe, assessment and menu 

analysis and the order in which they are displayed. Lists can be given names and 

saved for re-use. You can have as many lists as you wish.  

The difference between the functions on the Tasks and the Admin menus is only 

effective, when Dietplan is set up with User Accounts and is managed by a System 

Administrator. Lists created and saved by the administrator are accessible to all 

users from the Tasks menu, but they are labelled as Standard definitions and the 

list contents cannot be altered. You can use this, for example, to produce 

departmental standard lists so that all reports contain the same information. 

12.10 Define standard reports 
From the Admin menu, choose Define standard reports  

This function is identical in behaviour to the define report content function that can 

be called from the View menu by any user. It is used to create or recall a report 

definition that specifies the appearance and content of a Dietplan report. The 

definitions can be given names and saved for re-use. You can have as many 

definitions as you wish.  

The difference between the functions on the View and the Admin menus is only 

effective, when Dietplan is set up with User Accounts and is managed by a System 

Administrator. Definitions created and saved by the administrator are accessible to 

all users from the View menu, but they are labelled Standard definition and the 

contents cannot be altered. You can use these, for example, to produce 

departmental standard definitions so that all reports have the same format.  

12.11 Define standard graphs 
From the Admin menu, choose Define standard graphs  

This function is identical in behaviour to the define graphs function that can be 

called from the View menu by any user. It is used to create or recall a graph 

definition that specifies the appearance and content of a Dietplan graph. The 

definitions can be given names and saved for re-use. You can have as many 

definitions as you wish.  

The difference between the functions on the View and the Admin menus is only 

effective, when Dietplan is set up with User Accounts and is managed by a System 

Administrator. Definitions created and saved by the administrator are accessible to 

all users from the View menu, but they are labelled Standard definition and the 

contents cannot be altered. You can use these, for example, to produce 

departmental standard definitions so that all graphs have the same format. 

12.12 Managing your data 

12.12.1 Import Dietplan records 
From the Admin menu, select Import Dietplan records.  

You can select recipes, menus or assessments and copy them from a Dietplan7 

database file into your main database. The contents of the file will have been 

exported from this or any other copy of Dietplan7.  
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You can import different analysis types from the same file, but only one type at a 

time. Use the group of radio buttons in the upper-left corner to make your 

selection. Any user-added foods contained in an imported analysis will also be 

imported automatically but you can also explicitly import some or all of the user-

added foods in the file by selecting the appropriate button.  

 

Enter, or browse for, the location and name of the file containing the records to be 

imported.  

The usual search methods can be used to locate a list of candidates for import, or 

use Pre-select or the Enter key to list them all. Select the items to be exported 

from the returned list, click Select all or press Ctrl/A to select them all.  

Click the Import button to copy the selected items into your Dietplan database 

and click Close to dismiss the page. To import other analysis types from the same 

file, select the new type and repeat the process.  

If, during the import, an analysis of the same reference code already exists in the 

database, a message is displayed and your decision is requested, to overwrite the 

existing record or not.  
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If you decide to cancel, no records are imported, even those apparently copied 

before the duplicate was reported.  

12.12.2 Export Dietplan records 
From the Admin menu, select Export Dietplan records.  

You can select recipes, menus or assessments and copy them from your main 

database to a Dietplan7 database file, which can be archived or sent to another 

Dietplan7 user, on disk or CD or as an email attachment. The contents of the file 

can be selectively imported into this or any other copy of Dietplan7.  

You can export different analysis types to the same file, but only one type at a 

time. Use the group of radio buttons in the upper-left corner to make your 

selection. Any user-added foods contained in an exported analysis will also be 

exported automatically but you can also explicitly export some or all of your user-

added foods by selecting the appropriate button.  
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Enter, or browse for, the location and name of a file to contain the exported 

records. If it is a new export, choose a name for the file and a new export file will 

be created, otherwise specify an existing file. Do not specify an extension to the 

filename (such as .txt ). Dietplan will create an extension to the name that 

depends on the database management system being used. Currently it will be .sl3.  

The usual search methods can be used to locate a list of candidates for export, or 

use Pre-select or the Enter key to list them all. Select the items to be exported 

from the returned list, click Select all or press Ctrl/A to select them all.  

Click the Export button to copy the selected items into your file. To export other 

analysis types into the same file, select the new type and repeat the process. Click 

Close to dismiss the page. 

12.12.3 Archive Dietplan records 
From the Admin menu, select Archive Dietplan records.  

The Archive function is equivalent to Export followed by Delete Dietplan records. You 

can select recipes, menus or assessments and move them from your main database to 

a Dietplan7 database file. The selected records are then deleted from the 

database. One or more copies of the archived data file should be kept securely and, if 

the contents are required in the future, they can be restored using the Import Dietplan 

records function. 

You can archive different analysis types to the same file, but only one type at a time. 

Use the group of radio buttons in the upper-left corner to make your selection. Any 

user-added foods contained in an archived analysis will also be included automatically 

but will not be deleted from the database. User added foods and Recipes as foods can 

not be selected as a data type for archive.  
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Enter, or browse for, the location and name of a file to contain the archived records. If 

it is a new archive, choose a name for the file and a new archive file will be created, 

otherwise specify an existing file. Do not specify an extension to the filename (such as 

.txt ). Dietplan will create an extension to the name that depends on the database 

management system being used. Currently it will be .sl3.  

The usual search methods can be used to locate a list of candidates for archive, or use 

Pre-select  or the Enter key to list them all. Select the items to be archived from the 

returned list, click Select all or press Ctrl/A to select them all.  

Click the Archive button to copy the selected items into your file and then delete them 

from the database. The search list will then be updated to show only the items that 

remain, if any. To archive other analysis types into the same file, select the new type 

and repeat the process. Click Close to dismiss the page. 

When archiving assessments, the owning registration record is also archived. During 

deletion, if the registration record is left owning no assessments, it too is deleted. 

12.12.4 Delete Dietplan records 
From the Admin menu, select Delete Dietplan records.  

You can select recipes, menus, assessments or user-added foods and delete them 

from your main Dietplan7 database. Note that deleted items are removed 

permanently from the database and cannot be recovered. If there is the 

possibility of the records being required in future, use the Archive Dietplan records 

function instead, which will export and then delete the records.  
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You can only delete one type at a time. Use the group of radio buttons in the 

upper-left corner to make your selection. Currently no checks are made on whether 

a food or recipe is being used in any other analysis.  

 

  

The usual search methods can be used to locate a list of candidates for deletion, or 

use Pre-select or the Enter key to list them all. Select the items to be exported 

from the returned list, click Select all or press Ctrl/A to select them all.  

Click the Delete button to remove the selected items from your Dietplan database 

and Close to dismiss the page. To delete other analysis types, select the new type 

and repeat the process.  

When deleting assessments, the owning registration record is examined. If it is left 

owning no assessments, the registration record itself is deleted. 

12.12.5 Replace ingredient in recipes 
From the Admin menu, choose Recipe maintenance then Replace ingredient in 

recipes 

If you have a number of recipes that contain the same ingredient, it might become 

necessary to change that ingredient for another, similar ingredient in all the recipes 

- due to a change of supplier, for example. 
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Specify or Browse for the ingredient data-source and reference-code that you 

want to replace and all the recipes containing that ingredient will be displayed. 

Select all, or those recipes that you wish to change and then specify or browse for 

the replacement ingredient and click Replace. 

12.12.6 Verify recipes 
From the Admin menu, choose Recipe maintenance, then Verify recipes 

This function scans all recipes, that may contain other recipes, that may contain other recipes 

etc. and reports - into the messages and errors window - all references to non-existent recipes 

and the recipe(s) that contain them. 

12.12.7 Change registration number 
From the Admin menu, choose Registrations maintenance, then Change 

registration number  

Use this option to change an individual's current registration number with the 

option to copy assessments over to the new number and also to delete the original 

number.  
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Enter the Current Registration number to be changed, or click Browse to search 

for it. The name, sex and date of birth of the selected individual are displayed for 

confirmation. Enter the New Registration number, which must be an unused 

number. Click the check boxes if you want existing assessments to be copied to the 

new number and if you want the old number, and its associated assessments to be 

deleted.  

If you choose not to delete the old registration number, you will have two copies of 

the same personal details and assessments under two different numbers. There 

may be occasions, say for student exercises, when you may wish to do this.  

12.12.8 Transfer assessments 
From the Admin menu, choose Registrations maintenance, then Transfer 

assessments  

Use this option to move one or more assessments from one registration number to 

another. This can be used if one or more assessments are entered in error under 

the wrong registration number.  
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Enter, or click Browse to search for, the Registration numbers that you want to 

transfer the assessments From and To and verify the personal details to confirm 

that both are correct. Click Select assessments to produce a list of assessments 

currently belonging to the from registration  

 

Tick the checkbox alongside each assessment that you want to transfer and click 

Select. To effect the transfer, click the Transfer button on the Transfer page of 

the notebook. The fields on the page are all cleared after a successful transfer. 

12.12.9 Remove unused registrations 
From the Admin menu, choose Registrations maintenance, then Remove 

unused registrations  

Use this option to delete selected registration records from the database from a list 

of those with no associated assessments.  
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Click Select all to tick the checkbox alongside every registration record or 

tick/untick the boxes individually  then click Delete. Once deleted, the records 

cannot be recovered.  

12.12.10 Delete all category definitions 
From the Admin menu, choose Food categories, then Delete all category 

definitions  

Select this option if you would like to remove all the pre-defined category 

definitions before creating your own.  

 

With the exception of the [dried] Fruit, Vegetables and Nuts category definitions 

used by the Nutrition Profile Model, every detail of the current set of category 

definitions and flags will be deleted. Once removed, the definitions cannot be 

recovered.  
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12.12.11 Update foods in analyses 
From the Admin menu select Update foods in analyses. 

This function is only of use for installations that have been upgraded from the 

previous Dietplan6 software that contained earlier foods from the UK Composition 

of Foods tables. The Dietplan7 database contains the most recent (2014) foods 

from McCance & Widdowson's 7th Edition (MW7) and the revised Composition of 

Foods Integrated Dataset (ID2). With this option the foods in selected analyses can 

be updated to use the most recent food codes. While this is more likely to be of use 

for recipes and menus rather than historical assessments and food diaries, the 

latter can also be updated if required, perhaps to progress an ongoing project or 

study. 

 

All the foods and ingredients in the selected analyses are examined and any 

with earlier data source codes MW5, MW6, FAT, IDS and UKN that have been 

replaced by a corresponding food in the new ID2 datset will have its data source 

and food code changed to that of the replacement food.  
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On clicking Update a message is displayed showing the number of ingredients and 

analyses updated and, if greater than zero, this is followed by a detailed list of the 

affected items.  
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Click Report to produce this in PDF format that can be printed or saved if required.  

 

12.13 Backup and restore 

12.13.1 Backup Dietplan database 
From the Admin menu, select Backup Dietplan database  

This allows a copy to be made of the entire Dietplan7 database. The minimum 

database size is about 85 Megabytes it but could be up to twice this size depending 

on the additional food tables and user-saved analyses it contains. The copy should 

be made either to a removable storage medium or across to a remote, network 

disk drive. The purpose of the backup is to keep copies of the Dietplan database 

safe from the effects of a hard-disk failure or the total loss of the computer system. 

The backup takes a snapshot of the main Dietplan7 database and stores it in a 

compressed Zip file that is typically 4 to 6 times smaller than the original. 
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You can specify the name of the zip file and where it is to be created. The default 

name is based on the current date and time and is of the form: 

Dp6Backup-YYYYMMDD-HHMM.zip 

On successful completion, the full path name and size of the created backup are 

displayed.  

There is an option for Auto-backup on exit on the Preferences menu that may be of 

particular use if running the Portable version of the software from a USB flash 

drive. 

The backup and restore options menu options are only enabled when no other 

activities are in progress, that is, no workbook pages are open. Also these options 

can only be used with the default embedded Sqlite database. If you have a multi-

user installation with a client-server PostgreSQL or Microsoft SQL Server database, 

the recommended backup and restore functions associated with these database 

should be used. 

12.13.2 Restore Dietplan database 
From the Admin menu, select Restore Dietplan database  

This function allows the database, perhaps of a freshly-installed copy, of Dietplan7 

to be restored to the exact state of a previously backed-up copy of an entire 

database. With this option, data restoration is an all or nothing activity and the 

whole of the current database is replaced by the contents of the selected backup 

copy. To restore selected items from a backup into the current database without 

replacing it, choose Restore selected items from the Admin menu.  
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The names, dates and locations of previous backups are displayed and whether 

they are currently accessible on the system. You can select any of the available 

backups and restore it, after a confirmation message.  

 

The following message is displayed if you select a backup that is not currently 

available 

 

You can remove any item from the historical list by selecting it and clicking Delete. 

If the backup copy itself is accessible (Available= Yes) then it will be deleted, after 

conformation. Otherwise this only removes the history of the item. 

If your current database is a new installation of Dietplan, say, following a disk 

failure, the backup history will not be available. In this case you can locate your 

backup copy by using the Search button.  
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After the database has been restored a confirmation message is displayed 

and the program is restarted using the restored database. 

12.13.3 Restore selected items 
From the Admin menu, select Restore selected items 

This function allows you to select an earlier database backup and restore as many 

individual, selected items - recipes, menus, personal assessments and user-added 

foods - as you wish. 

The initial selection of the backup copy to restore from is identical to the selection 

described in the previous section. 

 

Once selected, the backed-up database is opened and the same options are 

available as in the import database records function described earlier. 
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12.14 Access management 

12.14.1 Enable user accounts 
When first installed, Dietplan does not require users to be registered in order to 

use the software, and anyone can access the system administrator functions and 

potentially make significant changes to the system and the contents of the 

database. When user accounts have been set up, only registered users can access 

the system and only those designated as a system administrator when they are 

registered can use the functions on the Admin menu. Another significant 

advantage of having individual user accounts, is that each registered user can save 

their own personal program preferences, lists and definitions in the database.  

User accounts are available with the Professional version of Dietplan7, but not with 

the Personal version. Only a system administrator can register and specify the 

privileges of new users.  

To activate user accounts, from the Admin menu, select Enable user accounts. 

Before Dietplan enables user accounts, at least one user with system administrator 

privileges must be registered.  

 

When user accounts have been anabled, a tick or checkmark appears beside the 

Enable user accounts item in the menu. If you select the menu item again, then 
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accounts become disabled and the checkmark is removed. Disabling user accounts 

does not delete any registered user details.  

 

12.14.2 Register users 
From the Admin menu, select Register users  

Use this function to register a new user or to edit the details or delete an existing 

user.  

 

A notebook page is opened showing a list of all currently registered user names, 

their administrator privileges, the number of times they have logged in and the 

date of the most recent access, plus any other user details recorded.  

Click Add to create a new user registration, Edit to amend the details of an entry 

and Remove to delete an existing registration completely.  

You can either link user registrations to their authenticated OS (e.g. Windows) 

account names or you can allocate each user a unique login name and associated 
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password. Linking a user to their OS account means that their identity is already 

validated and Dietplan will start without any further challenge. If you allocate a 

name, the user will have to supply that name and password every time they run 

Dietplan. This was originally the only way of setting up Dietplan user accounts but 

it has since been supplemented by using the OS account, which is now the 

recommended method. You can mix the two types if you wish, with some users 

gaining access via their OS identity and others needing to log in explicitly. 

However, explicit names cannot be used if there is a self-registering OS <userid > 

present as described below.  

Using OS user names  

Ensure that the Use OS login names box is checked 

 

Initially, the Login Id field is enabled and contains the entry <userid> . This is a 

special, symbolic name that represents any OS (eg Windows) user who has not 

been explicitly registered within Dietplan. So, for example you could explicitly 

register one or more users and give them System administrator rights and then 

permit all, say, students to self-register via this symbolic entry and be given the 

privileges declared here in this dialog. The self-registration is automatic and 

transparent the first time a new user logs in. The only effect is that the real user 



Dietplan7 User Guide 

 166 

name, together with the login history then appears in the register of users. If you 

do not wish to allow auto-registration, ensure there is no registration entry with the 

name <userid>. To register a specific OS user, enter their exact OS Login Id.  

By default the Home directory is <OS home>/Dietplan7. This an automatically 

created folder/directory called Dietplan7 in the private partition or home folder that 

the operating system creates when it registers the user. All the user's saved 

reports, graphs and other files are written to subfolders (definable by the user via 

Edit|Preferences) of this home directory.  

If Dietplan is installed on a network drive and so is available to multiple 

workstations, access is restricted to the number of concurrent users that have been 

licenced. To prevent an inactive user from denying access to others by failing to 

close down the program, an inactivity timer has been introduced. This has a default 

value of 20 minutes but can be set for individual users to between 5 minutes and 5 

hours, or Never. If Dietplan remains inactive - no keyboard or mouse activity - for 

the specified period, after a warning message and a 30 second grace period, the 

user session will be terminated. Any unsaved work will be lost. 

Check the boxes in the Privileges panel to grant these to the new user. A System 

administrator has full access to all the items on the Admin menu, including the 

rights to create and delete registered users.  

The right to Save to database allows the user to save recipes, menus and 

assessments in the main database, where they are accessible to all other users. If 

this privilege is not given, the user cannot do so but can still save their work in a 

private database area that is created in their own home directory. To the user this 

appears as a seamless extension to the main database and they should not be 

aware of any differences.  

Import catering data files appears if the Dietplan licence includes the ability to 

import data files from catering packages like Manna and Menumark. Enable this 

privilege for the users allowed to perform this task.  

To register a specific OS user, enter their exact OS Login Id.  
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User details can optionally be entered to provide more information about the user's 

identity. They are only for information within the registration record.  

Using explicit user names  

Ensure that the Use OS login names box is not checked  
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Every registered user must be allocated a unique Login Id. There are no restrictions 

on the length and content of the name. It is not case sensitive.  

You also need to allocate each user a password. Once it is entered, only the owner 

should be told, as the security of the whole system depends on the responsible use 

of passwords. Passwords are never displayed on screen so each must be entered 

twice here to confirm its validity. It is case sensitive and must be at least six 

characters long and should not be anything that could be guessed easily and a 

combination of letters and numbers is better than an ordinary word. If a user 

password is forgotten, replace it with a new one using the Edit option.  

The rest of the fields are the same as when registering a user via their OS login as 

described above. 

If Change password is checked, the user can change their own password at any 

time using the Change password option on the Edit menu.  

12.14.3 Register user groups 
From the Admin menu, select Register user groupss  

Use this function to register a new user group or to edit the details or delete an 

existing user group.  
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Click Add to create a new user group or Edit to amend the details of an existing 

one. 

 

The Group Id is the item with which individual users are associated when they are 

made members of the group and with which new Dietplan registration records are 

"Created by" when any member of the group creates one. The Group Description 

may be used to provide any information that helps identify each group. The list of 

defined groups in the earlier Register Group screen shows the number of members 

(users) in each group and the number of Dietplan Registration records the group 

has created. 

 

Click Members in this screen to display the user names belonging to the 

highlighed group. 
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A group can be deleted using the Remove button only if it has no members and no 

associated registration records. 

Individual users can be added as members of a group using the Add or Edit 

buttons in Register Users on the Admin menu and selecting the appropriate Group 

Name from the drop down list. 
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A user can only be a member of one group at any time, but can be assigned to 

another group (or None) by editing that users record. 

To summarise, user groups are used to control access to Dietplan registration 

records and their associated assessments. Such records created by a user 

belonging to any group are only visible to the members of that group and all other 

users are not aware of the existence of those records. As before, records created 

by a user who is not in any group are accessible to everyone, as are all foods, 

recipes and menus regardless of who created them. 
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13. Glossary 
13.1 Analysis groups 
Some types of analysis, that is, menus and intake diary assessments, require you 

to divide the analysis into a specified number of days, meals, courses and choices 

of dishes. These are referred to as analysis groups and the foods intended for, or 

consumed in each individual group are entered and stored separately within each 

group.  

13.2 Averaged intake 
An averaged intake assessment records the total consumption over a specified 

number of days with no information about when each food was eaten. At the end, 

an analysis can be produced that reports both the total and average daily intake.  

13.3 Dietary Reference Values 
A term used to cover Reference Nutrient Intake (RNI), Estimated Average 

Requirement (EAR) and Lower Reference Nutrient Intake (LRNI). The values 

recommended by the Committee on Medical Aspects of Food Policy (COMA) in 

1991. 

13.4 Estimated Average Requirement 
For energy, protein, a vitamin or mineral, The EAR for a group of people is the 

amount where about half will usually need more than the EAR, and half less.  

13.5 Food group 
Every food in McCance & Widdowson's, The Composition of Foods and its 

supplements has been allocated a food group code of one, two or three letters. The 

groups are hierarchical so, for example, group A includes group AB which, in turn 

includes group ABC.  

13.6 Intake diary 
An intake diary records a person's consumption on individual days throughout the 

assessment period. The consumption of individual meals and also courses within 

meals can also be recorded if required. In many respects this is similar to a menu 

analysis except it records what is actually eaten rather than what is available.  

13.7 Lower Reference Nutrient Intake 
For protein, a vitamin or mineral, The LRNI is an amount of the nutrient that is 

enough for only the few people in a group who have low needs.  

13.8 Nutrient exchange value 
Nutrient exchange values answer questions of the form: what quantity of this food 

is required to supply 10 grams of carbohydrate? That is, you specify amount of the 

nutrient you want and Dietplan calculates the quantity of the food or ingredient 

needed to contain that amount.  

13.9 Portable document format (PDF) 
Originally developed by Adobe Inc. as an extension of the Postscript printing 

standard, PDF is now a universally accepted format for electronic documents. It is 

portable across all computer platforms and the internet via the freely available 
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Acrobat Reader and the open-source Ghostview and GhostScript tools that can be 

used for both viewing and printing PDF files.  

13.10 Portable network graphics 
PNG format is a commonly used method of storing bit-mapped images in computer 

files. It compresses the information to minimise the file size but the image can be 

reconstructed without loss. PNG format files can be displayed by a wide variety of 

software including most, if not all, web browsers, and image processing and desk-

top publishing packages.  

13.11 qualifying indicator 
The letters below can follow the value of any nutrient total. They mean that, for 

one or more contributory foods:  

d nutrient computed by difference method  

e nutrient quantity estimated  

+ nutrient present in significant, unknown amounts  

m nutrient value missing  

13.12 RDA 
Recommended daily amount. A value required by the EC directive on food labelling.  

13.13 Reference Nutrient Intake 
For protein, a vitamin or a mineral, the RNI is an amount of the nutrient that is 

enough, or more than enough, for about 97% of people in a group. If average 

intake of a group is at RNI, then the risk of deficiency in the group is very small.  

13.14 Scientific (E-format) notation 
In scaled "E" format - the number displayed must be multiplied by the power of 10 

shown after the E character.  

For example: 24681E6 represents 24681 times 10 to the power 6 (i.e. times 

1,000,000)  

So, the quantity is 24,681,000,000  

This will only happen rarely when extremely large numbers are involved. The 

easiest way to interpret the E notation is to mentally add as many zeros to the 

value as the number shown after the E.  

13.15 UK Nutrient Databank 
The UK Nutrient Databank is supplied and maintained by the Food Standards 

Agency. The material is Crown copyright and is reproduced in Dietplan under 

licence from the Controller of Her Majesty's Stationery Office.  

The complete databank comprises food and nutrient values from the 5th, 6th and 

7th summary editions of McCance & Widdowson's The Composition of Foods 

together with all the published supplements to the 4th and 5th editions plus the 

new and revised foods in the Composition of Foods integrated data set.  
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